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WHAT IS SARP?

Mission

The mission of the Scholarly Activity and Research Program (SARP) is to promote the self-
efficacy and professional identity development of future physician-scientists by providing
mentorship opportunities, didactic and experiential learning in research activities, providing
financial support for travel funding and grant support for internal research by Foster School of
Medicine (FSOM) medical students and Texas Tech Health El Paso faculty.

Vision

The vision of SARP is to promote a positive environment for didactic and experiential learning in
research to promote the self-efficacy and professional identity development of future
physician-scientists and by infrastructure development, establishment of thematic research
pipelines, promoting multidisciplinary research collaboration, integrating education and
research, launching a distinction program in molecular medicine, promoting scholarly activities,
securing funding and support, and continued evaluation and adaptation.

Overview

The Foster School of Medicine Scholarly Activity and Research Program (SARP) Course allows
medical students to design and execute independent research or scholarship under the
guidance of faculty mentors (Texas Tech Health El Paso faculty or approved faculty associated
with other institutions). A wide variety of topics and research areas are available in three broad
categories, allowing for a project to be tailored to a student’s background and interests: 1) basic
clinical and translational research; 2) epidemiology, community-based, behavioral, public, and
environmental health; and 3) medical humanities, qualitative research, and medical education
research. All projects must comply with federal and institutional requirements (e.g., IRB, IBC
and IACUC).

The overall goal of the SARP Course is to engage and educate medical students about the
process of addressing a scholarly or research question. This hands-on experience will increase
the student’s awareness and appreciation of the importance of research in providing the basis
for evidence-based medical knowledge. This course will expose students to new ideas and
mentorship and help them develop skills to strengthen their medical training and broaden their
perspective on how new knowledge is obtained and disseminated. The SARP Course
encourages students to seek a deeper understanding of biology and disease processes through
a scholarly approach that will make them stronger physicians and valued members of the
medical community.

The SARP Course is completed during a student’s time at FSOM. Research or scholarship
pursued before matriculating to the FSOM cannot be used directly to fulfill this requirement;
however, a student can continue working on earlier projects or with a previous mentor. In this
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case, clear documentation explaining how the SARP activities are extensions of any prior work
must provide sufficient detail about the continuation of work as an FSOM student. Students
participating in group projects (where two or more students work with a single mentor) should
identify a distinct hypothesis or research question that can distinguish their contribution and
provide for an independent SARP Final Report and SARP Poster. Please note that case reports
and narrative reviews are not acceptable SARP Course Projects; however, systematic reviews
and metanalyses are appropriate as they are based on a research question and should follow
PRISMA guidelines. (https://www.prisma-statement.org/)

Educational Methods and Learning Experiences

The SARP Course focuses on the student/mentor relationship. Once a good match is made, the
mentor is expected to closely guide the student in developing the Project Plan, be actively
involved in executing the project, and help the student develop the Final Report and Poster. To
optimize the mentor/student experience, a faculty mentor is restricted to a maximum of five

MS1 student h .
ear, SARP Completion Tracks
AY 1 AY 2 AY 3 AY 4

SARP mentors will review I ! ! I !

each assigned component i s
a research question or interest
Of the SARP Course aresearch mentor

. . [_Refine=> project plan
(Project Plan, Final Report [CRefine> B ot

and Poster) and provide Track 2: c.mm " -- Fnal @
the student with narrative Aracx < — Report

aresearch question or interest

feedback. The criteria for [CFind > a research mentor
. - prmect plan
assessing these ERecute=> project
ssinments rebwsedon o, N e N N A
_— w Report

the SARP Course Goals and [Develop=> a research question or interest

: : : a research mentor
Objectives outlined below. T R soject slon

[ Executé= project

Components of SARP
The SARP requirement is Figure 1

a 3-credit course
consisting of three 1-credit components:

e One credit is for the selection of a mentor, preparation, and submission of a Project Plan
and completion of CITI Training; completing two Progress Reports for Track 2 completion
or completing four Progress Reports for Track 3 completion.

e Selection of a mentor and preparation of the Project Plan is due at the end of the first
year.

e One credit for project execution and submission of the Final Report

e One credit for a Poster Presentation.
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WHAT ARE RESEARCH AND SCHOLARSHIP?

Research and scholarship are related but distinct concepts in the academic world. Both involve
a commitment to pursuing knowledge and understanding but differ in focus, methodology, and
outcomes.

Research

Research is a systematic investigation to discover new knowledge, solve specific problems, or
contribute to the existing body of knowledge in a particular field.

Characteristics:
Systematic and Methodical: Involves structured methods and procedures to gather
data, test hypotheses, and analyze results.
Originality: Seeks to generate new knowledge, insights, or innovations that are
unknown.
Empirical Evidence: Often relies on empirical data collected through experiments,
observations, surveys, or other methods.
Specific Goals: Aimed at answering specific research questions or testing hypotheses.
Publication and Peer Review: Results are typically published in academic journals and
subjected to peer review to ensure validity and reliability.
Types:
Basic Research: Focuses on fundamental principles and theories without immediate
practical applications.
Applied Research: Aimed at solving practical problems or developing new technologies
or treatments.
Clinical Research: Involves studies on human subjects to understand health and disease,
often leading to clinical trials.
Translational Research: Bridges the gap between basic science and clinical application.

Scholarship

Scholarship encompasses a broader range of academic activities that contribute to the
understanding, interpreting, and disseminating knowledge. It includes research, teaching,
learning, and the application of knowledge.

Characteristics:
Broad Scope: Encompasses a wide variety of intellectual activities, including research,
teaching, writing, and public engagement.
Integration and Synthesis: Involves integrating existing knowledge, synthesizing
information from various sources, and developing new interpretations or perspectives.
Dissemination: Focuses on sharing knowledge through publications, lectures,
presentations, and other forms of communication.
Educational Role: Often involves teaching and mentoring students, developing curricula,
and contributing to educational practices.
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Critical Analysis: Involves critically evaluating existing knowledge, theories, and

practices.

Service and Application: Includes applying knowledge to solve real-world problems,
contribute to professional practice, and engage with the broader community.

Key Differences

Research is primarily focused on creating new knowledge. Scholarship is broader, including the
creation, integration, application, and dissemination of knowledge. Research involves
conducting experiments, collecting data, analyzing results, and writing research papers.
Scholarship can include many activities, such as teaching, writing textbooks, developing new
teaching methods, engaging in public discourse, or applying knowledge to practice.

Table 1. Summary of Different Characteristics of Scholarship and Research

Definition The pursuit of academic The systematic investigation
knowledge and and study of materials and
understanding through study | sources to establish facts and
and critical analysis. reach new conclusions.

Purpose To develop a deep To discover new information,
understanding and validate existing knowledge,
knowledge in a particular or solve specific problems.
field.

Scope Broad, often encompassing Narrow, focused on specific
the synthesis of existing guestions or hypotheses.
knowledge and theories.

Methodology Critical analysis, literature Experimental, observational,
review, theoretical qualitative, quantitative
exploration. methods.

Outcome Development of theories, Empirical data, new findings,
models, and comprehensive | validated theories, practical
understanding. solutions.

Nature of Work Often reflective, analytical, Empirical, data-driven, and
and theoretical. experimental.

Primary Activities Reading, analyzing, Conducting experiments,
critiquing, synthesizing surveys, observations, data
existing works. collection.

Dissemination Academic journals, books, Research papers, conference
essays, reviews. presentations, reports,

scientific journals.

Evaluation Criteria Depth of analysis, originality | Accuracy of data, validity of
of thought, contribution to results, reliability of
understanding. methodology.
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Time Frame Often longer-term, Can be shorter-term, project-
continuous process. based.

Impact Influences academic Direct impact on industry
discourse, education, and practices, technological
theoretical frameworks. advancements, and societal

issues.
Intersection

While distinct, research and scholarship often intersect. High-quality research contributes to
scholarship by adding to the body of knowledge, which scholars then disseminate through
teaching and other forms of communication. Conversely, scholarship can inform and inspire
new research questions and methodologies. Both research and scholarship are vital in the
context of medical education and practice. Research drives medical advancements and
innovations, while scholarship ensures that this knowledge is effectively communicated,
applied, and built upon to improve healthcare outcomes.
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RESEARCH ETHICS AND INTEGRITY IN MEDICAL RESEARCH

Introduction

Research ethics and integrity are fundamental components of conducting sound and credible
research, particularly in the medical field. As future healthcare professionals, medical students
must understand and adhere to ethical principles to ensure the welfare of participants, the
credibility of research findings, and the advancement of medical science. This chapter will
provide an in-depth exploration of research ethics and integrity, focusing on the responsibilities
and challenges faced by medical students involved in various types of research.

Informed Consent
Informed consent is a cornerstone of ethical research. It ensures that participants are fully
aware of the research's nature, purpose, risks, and benefits before agreeing to participate.

Transparency: Researchers must provide clear and comprehensive information about
the study.

Voluntariness: Participation should be voluntary, without any coercion or undue
influence.

Comprehension: Researchers should ensure that participants understand the
information provided, which may require adapting the communication approach based
on the participants' background and language proficiency.

Confidentiality

Protecting the privacy of research participants is crucial. Researchers must take appropriate
measures to safeguard personal information and ensure that data is anonymized whenever
possible.

Data Protection: Implementing secure data storage and handling procedures.
Anonymization: Removing or coding identifiers to prevent the tracing of data back to
individual participants.

Beneficence and Non-Maleficence
Researchers are obligated to maximize benefits and minimize harm to participants.

Risk-Benefit Analysis: Carefully assessing the potential risks and benefits of the
research.

Minimizing Harm: Implementing strategies to reduce physical, psychological, and social
risks to participants.
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Justice

The principle of justice demands fair and equitable treatment of all research participants.
Equitable Selection ensures that the selection of participants is fair and not biased. Access to
benefits ensures that the benefits of research are distributed fairly among all groups.

Institutional Review Boards (IRBs) and Ethical Approval

Before commencing any research involving human participants, medical students must obtain
ethical approval from an Institutional Review Board (IRB) or equivalent ethics committee. IRBs
review research proposals and ensure that ethical standards are maintained. Preparing and
submitting a detailed research proposal for review, including protocols for informed consent,
data protection, and risk management, varies from institution to institution.

Conflicts of Interest

Conflicts of interest (COls) can arise when personal or financial interests potentially influence
the conduct of research. Researchers must disclose any potential COls to their institution and in
publications.

Misconduct

Research misconduct, including fabrication, falsification, and plagiarism, undermines the
integrity of scientific research. Research Misconduct can lead to retraction of publications, loss
of credibility, and legal or academic consequences. One key to preventing research misconduct
is to promote a culture of honesty and transparency in research. Avoiding research misconduct
is crucial to growth and development in establishing your professional identity as a medical
student and physician scientist.

Definitions:
Fabrication: Making up data or results.
Falsification: Manipulating research materials, equipment, or processes to misrepresent
results.
Plagiarism: Using others' ideas or words without proper attribution.

Case Studies

Case Report 1: Informed Consent Violation

John, a third-year medical student, is conducting a research project on the effects of a new drug
on blood pressure. He recruits participants from a local clinic. Due to time constraints, John
skips the detailed informed consent process, giving participants a brief overview instead. The
ethical issues contained within this case include failure to obtain proper informed consent.
Participants are not fully aware of the study's risks and benefits especially when potential for
harm to participants exists. The study is reported, and an investigation reveals the breach.
John's project is suspended, and he faces disciplinary action. The institution emphasizes the
importance of comprehensive informed consent.
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Case Report 2: Data Fabrication

Emily, a medical student, is struggling to meet the deadlines for her research on the effects of a
diet plan on diabetes management. To make the results appear significant, she fabricates data.
The ethical issues contained within this case include falsification of data. The falsification of
data compromises the integrity of the research and the resulting misleading conclusions could
affect patient care. A peer review uncovers inconsistencies. Emily's supervisor investigates,
revealing the fabrication. Emily is expelled from the program, and the institution implements
stricter data verification processes.

Case Report 3: Plagiarism

Michael, a second-year medical student, is working on a literature review for a research project.
Pressed for time, he copies substantial sections from published articles without proper citation.
The ethical issues contained within this case include, plagiarism, lack of originality and
intellectual dishonesty. The plagiarism is detected through software checks. Michael receives a
formal reprimand and is required to attend a workshop on academic integrity. His research
privileges are suspended for a semester.

Case Report 4: Conflict of Interest

Samantha, a medical student, is conducting research funded by a pharmaceutical company that
produces the drug being studied. She does not disclose this funding source in her research
publication. The ethical issues contained within this case include conflict of interest, potential
bias in research outcomes. Upon publication, the undisclosed conflict is discovered. Samantha's
paper is retracted, and she is required to disclose all funding sources in future research. The
institution revises its guidelines on conflict of interest disclosures.

Case Report 5: Coercion of Participants

Tom, a fourth-year medical student, is conducting a study on patient adherence to medication.
To ensure high participation, he pressures patients during their clinic visits, making them feel
obliged to join. The ethical issues contained within this case include coercion of participants,
violation of voluntary participation principle, psychological stress on patients. Patients report
feeling coerced. An ethics review board halts the study, and Tom is given counseling on ethical
recruitment practices. The institution strengthens oversight on participant recruitment.

Case Report 6: Misuse of Confidential Information

Linda, a medical student, accesses patient records for her research on chronic illness
management. She shares identifiable patient information with her peers to get their input on
the study. The ethical issues contained within this case include breach of patient confidentiality
that results in unauthorized sharing of sensitive information. A patient files a complaint upon
discovering the breach. Linda faces disciplinary action, and the institution enforces stricter
controls on data access and handling. All students receive additional training on confidentiality.

Case Report 7: Al-Generated Manuscript
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David, a third-year medical student, is overwhelmed with multiple academic commitments and
research projects. To manage his workload, he uses an Al tool to generate the manuscript for
his research on the efficacy of a new surgical technique. He presents the Al-generated text as
his own work without disclosing the use of Al. The ethical issues contained within this case
include misrepresentation of authorship, lack of transparency about the use of Al in generating
research content, potential inaccuracies or biases in the Al-generated text, and ultimately
undermining the academic and research integrity. During the peer review process, reviewers
notice inconsistencies and question the originality of the manuscript. An investigation reveals
the extensive use of Al in creating the text. David faces academic sanctions, and the manuscript
is retracted. The institution implements new guidelines requiring disclosure of Al use in
research and writing.

Case 8: Unauthorized Manuscript Submission

Alex, a final-year medical student, was eager to publish research to strengthen his CV for
residency application. Driven by his ambitions, he submitted several manuscripts to journals,
listing himself as the corresponding author without informing the principal investigator (PI) or
the co-authors. In addition, Alex frequently misrepresented his affiliations in the author
information, falsely claiming associations with prestigious institutions. This behavior raised
significant ethical concerns, including the unauthorized submission of manuscripts,
misrepresentation of author affiliations, breach of trust with the Pl and co-authors, and
violation of academic honesty and integrity principles. Such actions also risked damaging the
reputations of the institutions involved. One of the co-authors discovered the unauthorized
submissions when they were browsing their google scholar profiles to update their CV. An
internal investigation was launched, revealing Alex's misconduct. Consequently, the journals
retracted the submitted manuscripts, and Alex was expelled from the medical program for his
unethical behavior. To prevent similar incidents in the future, the institution introduced
mandatory workshops on research ethics and professional conduct for all students.

Conclusion

Adhering to ethical principles and maintaining integrity in research is paramount for medical
students involved in any type of research. Understanding and implementing informed consent,
confidentiality, beneficence, non-maleficence, and justice are essential. Obtaining ethical
approval, managing conflicts of interest, and avoiding research misconduct further ensure the
credibility and reliability of research findings. By upholding these standards, medical students
can contribute to advancing medical science while safeguarding the rights and welfare of
research participants.
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WHAT TYPES OF RESEARCH ARE AVAILABLE?

Medical students have the opportunity to engage in a variety of research types, each
contributing uniquely to the field of medicine.

Basic Science Research

Basic science research involves studying fundamental biological processes and mechanisms.
This type of research is conducted primarily in laboratories and aims to understand how living
organisms function at the molecular, cellular, and genetic levels.

Examples: Investigating the molecular pathways of cancer, studying the genetic basis of
diseases, or understanding the immune system's response to infections.

Skills Required: Laboratory techniques (e.g., PCR, Western blotting, flow cytometry, cell
culture), data analysis, critical thinking.

Clinical Research

Clinical research involves studies that directly involve patients or human subjects to evaluate
medical, surgical, or behavioral interventions. The goal is to improve patient care and treatment
outcomes.

Examples: Clinical trials testing new medications, observational studies on disease
progression, or outcomes research evaluating surgical procedures.

Skills Required: Patient interaction, including recruiting, data collection, understanding
of clinical protocols, and ethical considerations.

Epidemiology Research

Epidemiology research focuses on the distribution and determinants of health-related states or
events in populations. It aims to identify risk factors for diseases and to develop strategies for
prevention and control.

Examples: Studying the incidence and prevalence of diseases, identifying risk factors for
chronic illnesses, or evaluating the effectiveness of public health interventions.

Skills Required: Statistical analysis, data interpretation, knowledge of public health
principles, critical thinking.

Community Based Participatory Research

This type of research involves working with communities to understand and address their
health needs. It often includes participatory methods, in which community members are
actively involved in the research process.
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Examples: Assessing health needs in underserved populations, evaluating community-
based health programs, or studying the impact of health education initiatives.

Skills Required: Communication, cultural competence, data collection, community
engagement techniques.

Behavioral Health Research

Behavioral health research studies the interaction between behavior, mental and physical
health. It aims to understand how behaviors influence health outcomes and how to modify
behaviors to improve health.

Examples: Research on smoking cessation programs, studies on mental health
interventions, or exploring the relationship between lifestyle factors and chronic
diseases.

Skills Required: Understanding of psychological theories, data analysis, patient
interaction, and intervention design.

Environmental Health Research
Environmental health research investigates how environmental factors affect human health.
This includes studying the effects of pollutants, climate change, and occupational hazards.

Examples: Studying the health effects of air pollution, assessing the impact of climate
change on public health, or investigating occupational health risks in certain industries.
Skills Required: Environmental science knowledge, data analysis, risk assessment, and
understanding of public health policies.

Medical Humanities Research

Medical humanities research explores the intersection of medicine with the humanities,
including literature, history, ethics, and the arts. It aims to provide a deeper understanding of
the human experience in healthcare.

Examples: Studying the history of medicine, analyzing medical narratives in literature, or
exploring ethical issues in healthcare.

Skills Required: Critical analysis, writing, understanding of humanities disciplines, ethical
reasoning.

Medical Education Research
Medical education research focuses on improving medical training and education methods. It
aims to develop and evaluate new teaching strategies, curricula, and assessment tools.

Examples: Research on simulation-based learning, studies on the effectiveness of online
medical education, or evaluating new assessment methods for medical students.

12
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Skills Required: Educational theory knowledge, data collection and analysis, curriculum
development, and teaching experience.

13
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HOW DO | COME UP WITH A RESEARCH QUESTION?

Coming up with a research question as a medical student involves a combination of curiosity,
understanding of existing literature, and practical considerations.

Steps to Develop a Research Question

e Reflect on your interests within medicine—this could be a specific disease, patient
population, treatment method, or aspect of healthcare. Consider experiences from
clinical rotations, lectures, and personal observations that sparked your curiosity. Review
recent articles, reviews, and meta-analyses in your area of interest.

e |[dentify gaps in knowledge, controversies, or emerging areas where further research is
needed. Narrow down your broad area of interest to a specific topic. For example,
instead of focusing on "cardiovascular disease," you might narrow it down to "the
impact of diet on cardiovascular health in adolescents."

® Discuss your ideas with faculty members, advisors, and peers. They can provide valuable
insights, suggest resources, and help refine your topic. Given your resources and time
constraints, mentors can also help ensure your question is feasible.

® Assess the availability of data, resources, and subjects needed to conduct your research.
Ensure that your question is manageable within the timeframe and scope of your
medical studies. To refine your question, use frameworks such as PICO (Population,
Intervention, Comparison, Outcome) for clinical research or FINER (Feasible, Interesting,
Novel, Ethical, Relevant) criteria.

Characteristics of a Good Research Question

A good research question should be clear and unambiguous. Avoid vague terms and ensure that
others easily understand the question. A research question should be focused and specific. It
should target a particular aspect of a problem rather than being broad and general. Ensure that
the research question can be realistically answered given the available time, resources, and
expertise. Consider whether you can access the necessary data, subjects, and equipment. The
guestion should address a gap in the existing literature or offer a new perspective. Novel
research questions contribute to advancing knowledge in the field. The research question must
be ethically sound and respect the rights and well-being of participants. Ensure that your study
design complies with ethical guidelines and has the necessary approvals. The question should
be relevant to current issues in medicine and healthcare. It should have the potential to impact
clinical practice, patient outcomes, or health policy. The question should be structured to be
answered through research methods, whether qualitative, quantitative, or mixed methods. It
should lead to measurable outcomes or clear findings.

14
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Examples of Good Research Questions

Clinical Research: "What is the efficacy of a new antihypertensive drug compared to existing
treatments in lowering blood pressure in patients with stage 1 hypertension?"

Public Health: "What are the barriers to vaccination uptake among low-income communities,
and how can targeted interventions improve vaccination rates?"

Medical Education: "How does the use of simulation-based training in medical school affect the
confidence and skills of students in performing clinical procedures?"

Epidemiology: "What are the long-term health outcomes of children exposed to secondhand
smoke in utero and during early childhood?"

Quality Improvement: "How does implementing electronic health records impact the efficiency
and accuracy of patient care in a busy urban clinic?"

Refining Your Research Question
Developing a research question is often iterative. You may need to revise your question
multiple times based on feedback and further literature review.

15
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WHAT MAKES A GOOD HYPOTHESIS?

A good hypothesis is a fundamental part of the scientific method and a foundation for
experimentation and research. A hypothesis must be testable through experimentation or
observation. It should be possible to design experiments that can confirm or refute it. A
hypothesis should be structured in a way that it can be proven false. This means there must be
a potential outcome that would show the hypothesis is incorrect. A good hypothesis is clear and
specific, outlining the expected relationship between variables. Vague hypotheses are harder to
test and validate.

A hypothesis should be grounded in existing research and theories. A hypothesis often stems
from a literature review or previous findings. The simpler a hypothesis, the better. It should not
be overly complex and focus on a single relationship or effect.

A hypothesis should make predictions about the expected outcome of the experiment or
observation. A hypothesis should be logically consistent. The reasoning behind the hypothesis
should be sound and based on established scientific principles.

Example of a Good Hypothesis

Let's say you are studying the effect of sunlight on plant growth. A good hypothesis might be:
If plants are exposed to more sunlight, they will grow taller than plants that receive less
sunlight.

Testable: You can measure plant growth under different sunlight conditions.
Falsifiable: It's possible that plants do not grow taller with more sunlight.

Specific: It specifies the variable (sunlight) and the expected outcome (growth).

Based on Existing Knowledge: It builds on the understanding that sunlight is crucial for
photosynthesis.

Simple: It focuses on one variable's effect.

Predictive: It predicts the outcome of increased sunlight exposure.

Logical: The reasoning is consistent with known scientific principles.
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UNDERSTANDING VARIABLES

In biomedical research, correctly identifying and understanding different types of variables is
crucial for designing robust studies, analyzing data accurately, and interpreting results
effectively. This chapter explains independent, dependent, and nested variables, providing
relevant biomedical examples to illustrate their roles and relationships.

Independent Variables
An independent variable is a factor manipulated or categorized to observe its effect on a
dependent variable. It is the presumed cause in a cause-and-effect relationship.

Dependent Variables
A dependent variable is the outcome or response that is measured to assess the effect of the
independent variable. It is the presumed effect in a cause-and-effect relationship.

Nested Variables

A nested variable is a type of variable that is hierarchically structured within another variable.
Nested variables often occur in complex experimental designs where sub-groups are created
within the main groups.

Examples

Clinical Trial of a New Drug: In a study investigating the effect of a new antihypertensive drug,
the independent variable would be the treatment (e.g., drug vs. placebo).

Independent Variable: Type of treatment (new drug or placebo)

Dependent Variable: Blood pressure levels

Dietary Intervention Study: In research examining the impact of a low-sodium diet on blood
pressure, the independent variable is the diet type.

Independent Variable: Type of diet (low-sodium vs. regular diet)

Dependent Variable: Blood pressure levels

Exercise and Mental Health: In a study assessing the impact of exercise on mental health, the
independent variable is the exercise regimen.
Independent Variable: Exercise regimen (high-intensity vs. low-intensity vs. no exercise)
Dependent Variable: Levels of anxiety and depression
Definition

Multi-Center Clinical Trial: Consider a clinical trial conducted across multiple hospitals to test a
new drug for lowering blood pressure. Patients (nested variable) are nested within hospitals
(main variable).

Main Variable: Hospital (Hospital A, Hospital B, Hospital C)

Nested Variable: Patients within each hospital

17
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Independent Variable: Treatment type (new drug or placebo)
Dependent Variable: Blood pressure levels

Genetic Studies: In a study investigating genetic differences in drug metabolism, individual
genetic profiles (nested variable) are nested within broader population groups (main variable).
Main Variable: Population group (e.g., European, Asian, African)
Nested Variable: Individual genetic profiles within each population group
Independent Variable: Genetic marker
Dependent Variable: Drug metabolism rate

Conclusion

Understanding independent, dependent, and nested variables is essential for designing
effective biomedical research studies. Recognizing these variables and their relationships allows
researchers to structure their experiments correctly, choose appropriate statistical analyses,
and draw valid conclusions from their data. By applying these concepts, medical students can
enhance the rigor and impact of their research endeavors.
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THE MENTOR-MEDICAL STUDENT RELATIONSHIP

Research and scholarship are integral parts of medical education and professional
development. A successful research experience requires a productive and collaborative
relationship between mentors and medical students.

The Role of a Mentor

Advisor

The mentor provides expert guidance on research design, methodology, and the scholarly
process. This includes helping the student formulate research questions, develop study
protocols, and navigate the complexities of data analysis. The mentor supports the student in
identifying and accessing necessary resources, including funding, data, and research tools.

Teacher

The mentor educates the student on essential research skills and knowledge. This includes
training in specific techniques, understanding ethical considerations, and developing critical
thinking skills. Providing constructive feedback is a key role. The mentor reviews the student's
work regularly, offering insights and suggestions to improve the quality and rigor of the
research.

Role Model

The mentor demonstrates professional and ethical behavior, serving as a role model. This
includes showing integrity in research practices, fostering a respectful and inclusive
environment, and balancing research with other professional responsibilities.

Expectations of the Mentor

Accessibility

Mentors should be available for regular meetings and discussions. They should respond to the
student's queries in a timely manner and provide consistent support throughout the research
process.

Encouragement and Constructive Feedback

Creating a supportive and encouraging atmosphere is crucial. The mentor should motivate the
student, celebrate successes, and provide emotional support during challenges. The mentor
offers constructive and developmental feedback, helping the student refine their research
guestions, methodologies, and presentations. This feedback should be specific, actionable, and
aimed at fostering growth.

Responsibilities of the Mentor

Guidance and Resources
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Help the student develop a clear research plan, including specific goals, timelines, and
milestones. Assist the student in securing necessary resources such as funding, access to data,
and research tools.

Professional Development

Encourage and support the student's participation in conferences, workshops, and networking
opportunities. This exposure helps in broadening the student's understanding and professional
network. Ensure that the research adheres to ethical guidelines and institutional policies. The
mentor is responsible for guiding the student through the ethical review process and ensuring
compliance with all relevant regulations.

The Role of a Student

Learner

The student is primarily a learner, acquiring the knowledge and skills necessary for conducting
research and scholarship. This involves active engagement in learning opportunities provided
by the mentor.

Researcher
The student actively engages in the research process, including data collection, analysis, and
interpretation. This hands-on involvement is crucial for developing practical research skills.

Collaborator

The student works effectively with the mentor and other members of the research team.
Collaboration and communication are key to the success of the research project.

Expectations of a Student

Proactive Engagement

The student should take initiative in the research process, seeking guidance and feedback when
needed. This includes identifying areas where they need additional support and actively
pursuing learning opportunities.

Time Management
Managing time effectively is essential. The student must balance research activities with other
academic and clinical responsibilities, ensuring that each receives appropriate attention.

Commitment
Demonstrating dedication to the research project is crucial. The student should meet deadlines,
maintain a high standard of work, and show persistence even when faced with challenges.
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Responsibilities of the Medical Student

Preparation

The student should come prepared to meetings with progress updates, questions, and
discussion points. Another responsibility is regularly documenting and tracking the progress of
the research project. This includes maintaining a log of completed tasks, ongoing activities, and
future plans. The student should stay updated on relevant literature and advancements in the
field. This involves regularly reading and summarizing new research articles and integrating this
knowledge into the project.

Skill Development

The student should actively seek opportunities to develop research skills, such as statistical
analysis, literature review, and scientific writing. The student should utilize resources provided
by the mentor and seek additional training as needed.

Dissemination of Research

The student should contribute to disseminating research findings through presentations,
publications, and other scholarly activities. This is a crucial part of the research process and
helps advance medical knowledge.

Professionalism and Ethical Conduct

The student must show respect to the mentor and all members of the research team. This
includes valuing diverse perspectives and contributions, and maintaining a collaborative and
supportive environment. Clear and professional communication is essential. The student should
communicate regularly with the mentor, provide updates on progress, and promptly address
any issues or concerns. The student should be reliable and dependable, meeting deadlines,
attending scheduled meetings, and following through on commitments. The student must
maintain confidentiality of all research data and findings, adhering to institutional policies and
ethical standards. Any breaches of confidentiality should be reported immediately to the
mentor and appropriate authorities. The student must demonstrate integrity in all aspects of
their research activities, including accurate reporting of data, acknowledgment of sources,
honesty in all communications and actions, and adhering to ethical guidelines and institutional
policies.
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HOW DO | FIND A RESEARCH MENTOR?

Finding a research mentor as a medical student is crucial in advancing your academic and
professional career. Here are some strategies to help you identify and connect with a potential
research mentor:

Identify Your Research Interests
Start by defining your areas of interest within the medical field. A clear idea of what you want
to research will help you find a mentor whose interests align with yours.

Research Potential Mentors

Look for faculty members, researchers, and clinicians working in your area of interest.

Check the profiles of faculty members in their departments or related departments. Look for
authors of research papers that align with your interests. Attend relevant conferences,
seminars, and lectures to meet researchers and learn about their work.

Network

Ask your professors, college mentors, academic advisors, or clinical supervisors for
recommendations. Talk to fellow students who have engaged in research to get suggestions
and introductions. Join medical student organizations or professional societies that can provide
networking opportunities.

Evaluate Potential Mentors

Ensure their research aligns with your interests. Consider their experience in mentoring
students and their availability to provide guidance. Look for mentors with a good reputation in
the field and a track record of successful mentees.

Make Contact

Reach out to potential mentors with a professional and well-prepared approach. To make
contact, send a concise, respectful email introducing yourself, expressing your interest in their
research, and explaining why you seek their mentorship. Attach your CV and mention any
relevant experience or skills. If you don’t receive a response within a few weeks, send a polite
follow-up email.

Prepare for the Meeting

If a potential mentor agrees to meet with you, prepare thoroughly. Please read some of their
published papers and be ready to discuss their research. Have questions about their research,
expectations for mentees, and potential projects you could work on. Clearly articulate your
research interests and career goals.
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Assess the Fit

During the meeting, assess whether the mentor is a good fit for you. Consider if your working
styles and personalities are compatible. Ensure their expectations align with your availability
and goals. Evaluate the level of support and resources they can provide.

Formalize the Mentorship

If you both agree to proceed, formalize the mentorship. Discuss and set clear goals and
expectations for the research project. Outline a timeline for the project, including milestones
and deadlines. Schedule regular meetings to discuss progress, receive feedback, and address
any challenges.

Tips for a Successful Mentorship

Be Proactive: Take initiative in your research and maintain regular communication with your
mentor.

Be Open to Feedback: Be receptive to constructive criticism and use it to improve your work.
Stay Committed: Show dedication and commitment to the research project and your mentor’s
guidance.

Follow-up: A polite follow-up email can show your continued interest if you don’t hear back
within a few weeks.

Express Gratitude: Acknowledge and appreciate your mentor’s time and effort.
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WHAT IS A LITERATURE REVIEW AND HOW DO | DO ONE?

A literature review is a critical component of the research process, particularly in the early
stages of developing a research question. It involves systematically searching for, evaluating,
and synthesizing existing research related to a specific topic. For medical students and
researchers, conducting a thorough literature review provides a solid foundation to build a
meaningful and well-informed research question.

A literature review helps researchers understand the existing knowledge on a particular topic. It
provides insights into what has already been studied, the methodologies used, and the findings
and conclusions drawn by other researchers. By reviewing existing research, researchers can
identify gaps or areas that have not been sufficiently explored. These gaps present
opportunities for new research questions and studies that can contribute to advancing
knowledge in the field. A comprehensive literature review also ensures that researchers do not
duplicate existing studies unnecessarily.

Define Your Research Question
Start by clearly defining the research question or topic you want to explore. A well-defined
qguestion will guide your search and help you stay focused.

Search for Relevant Literature
Use multiple sources to find relevant literature:

Databases: Use academic databases like PubMed, Google Scholar, JSTOR, and PsycINFO.
Libraries: Access university library resources.
Reference Lists: Check the reference lists of key articles for additional sources.

Develop a Search Strategy

Create a list of keywords and phrases related to your topic. Use Boolean operators (AND, OR,
NOT) to refine your search. For example, use keywords such as "climate change," "global
warming," "environmental impact" or search strings such as "climate change AND global
warming," "climate change OR environmental impact" to refine search results.

Another strategy for a literature review is to incorporate Medical Subject Headings (MeSH)
terms, which are standardized sets of terms used to index and organize biomedical information.
Developed and maintained by the National Library of Medicine (NLM), MeSH terms facilitate
efficient and precise searching within the vast databases of biomedical literature, such as
PubMed. This chapter provides an overview of MeSH terms, their importance, structure, and
how to effectively use them in biomedical research. Use the MeSH database on PubMed to
identify appropriate MeSH terms for your topic. Enter your search term and review the
suggested MeSH terms.
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Evaluate the Sources

Critically evaluate the sources for relevance, quality, and credibility. Does the source directly
address your research question? Is the source peer-reviewed or published in a reputable
journal? Are the authors credible and recognized experts in the field?

Organize the Literature
Organize the selected literature in a way that makes sense for your review. Common methods
include:

Thematic Organization: Group studies by themes or topics.
Chronological Organization: Arrange studies by publication date.
Methodological Organization: Group studies by research methods used.

Summarize and Synthesize
Summarize the key findings of each study. Then, synthesize the information to identify
patterns, trends, and gaps in the research. This step involves:

Comparing and Contrasting: Highlight similarities and differences between studies.
Identifying Gaps: Point out areas where more research is needed.
Connecting to Your Research: Relate the literature to your research question.

Write the Literature Review
Structure your literature review with a clear introduction, body, and conclusion:

Introduction: Introduce the topic, state the purpose of the review, and outline the
scope.

Body: Present the literature in a structured manner (thematically, chronologically, or
methodologically). Summarize and synthesize the findings.

Conclusion: Summarize the main findings, highlight significant gaps, and suggest
directions for future research.

Cite Your Sources
Properly cite all your reviewed sources using the appropriate citation style (APA, MLA, Chicago,
etc.). This ensures academic integrity and allows readers to locate the original sources.

More Tips for a Successful Literature Review

e Stay Organized: Keep track of your sources and notes.

e Be Critical: Evaluate the quality and relevance of each study.

e Be Comprehensive: Include a wide range of sources to cover the topic thoroughly.
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e Stay Current: Include recent studies to ensure your review is up-to-date.

By following these steps, you can conduct a thorough and effective literature review that
provides a solid foundation for your research.

HOW CAN ENDNOTE HELP COMPILE A BIBLIOGRAPHY?

EndNote is a powerful tool for managing bibliographies and references. Here’s a step-by-step
guide to help you use EndNote effectively (for more detailed training on EndNote, please visit
the Texas Tech Health El Paso library for more information:

Install EndNote
Obtain EndNote from the TTUHSC El Paso library. Follow the installation instructions for your
operating system.

Create a Library
Open EndNote: Launch the EndNote application.
New Library: Go to File > New and create a new library. Name your library and save it to
a convenient location.

Add References
There are several ways to add references to your EndNote library:

Manual Entry
New Reference: Go to References > New Reference or click the New Reference button.
Select Reference Type: Choose the appropriate reference type (e.g., Journal Article,
Book).
Enter Details: Fill in the bibliographic details manually. Click Save when done.

Import from Databases
Search in Database: Use PubMed, Google Scholar, or your institution's library.
Export References: Look for an option to export citations (e.g., in RIS or EndNote
format).
Import into EndNote: In EndNote, go to File > Import > File. Select the file you exported
and import it.

Direct Export
Database Export: Some databases allow direct export to EndNote. Look for an option to
Export to EndNote and follow the prompts.
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Organize References
Groups: To organize your references, create groups. Right-click on My Groups and select
Create Group. Name the group and drag references into it.
Smart Groups: Use Smart Groups to automatically organize references based on search
criteria. Right-click on My Groups and select Create Smart Group.

Use EndNote with Word
Install EndNote Plugin: Ensure the EndNote plugin is installed in Microsoft Word. It
usually installs automatically with EndNote.
Insert Citations: Open your Word document. Place the cursor where you want to insert
a citation. Click EndNote in the Word toolbar, then Insert Citation. Search for the
reference and insert it.
Format Bibliography: Use the Style dropdown in the EndNote toolbar in Word to select
a citation style (e.g., APA, MLA, Chicago). EndNote will format your bibliography
according to the selected style.

Sync and Share Libraries
Sync Library: To sync your library across devices, create an EndNote account and log in
through Edit > Preferences > Sync.
Share Library: Share your library with colleagues through File > Share. Enter the
recipient’s email address.

Backup Your Library
Regular Backups: Regularly backup your EndNote library to avoid data loss. Go to File >
Compressed Library (.enlx) to create a backup file.

Tips for Effective Use
Regular Updates: Keep EndNote and its styles updated to ensure compatibility and
accuracy.
Customize Fields: Customize reference fields to suit your needs by going to Edit >
Preferences > Reference Types.
Learn Shortcuts: Familiarize yourself with EndNote’s shortcuts and features to increase
efficiency.

Troubleshooting Common Issues
Plugin Issues: If the EndNote toolbar doesn't appear in Word, go to Word’s File >
Options > Add-ins. Check if EndNote Cite While You Write is active.
Duplicate References: Use References > Find Duplicates to locate and manage duplicate
references.
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HOW TO DISSEMINATE YOUR RESEARCH

Research dissemination is sharing research findings with the broader scientific community and
the public. Effective dissemination ensures valuable knowledge reaches those who can benefit
from it, including researchers, clinicians, policymakers, and patients. This chapter covers key
aspects of research dissemination, focusing on publishing in high-quality journals, presenting at
reputable conferences, and avoiding duplication of research.

Preparing an Abstract

An abstract is a concise summary of a research paper, providing an overview of the study's
objectives, methods, results, and conclusions. It is often the first part of a paper that readers
and reviewers encounter, making it crucial for capturing their interest and conveying the
essence of the research.

Choose a title that reflects the content and significance of your research. Introduce the
research topic and state the primary objectives. Describe the study design, participants,
interventions, and analytical methods. Summarize the key findings, including any statistical
significance. Present the main conclusions drawn from the results and their implications.

Use clear and straightforward language to ensure the abstract is easy to understand. Avoid
jargon and complex sentences. Most journals or conferences have specific word limits for
abstracts (typically 150-250 words). Adhere to these limits while ensuring all critical information
is included. Include only the most important details about the study. The abstract should
provide a snapshot of the research without going into extensive detail. Write in an active voice
to make the abstract more engaging and direct. Emphasize what makes your study unique and
why it is important.

Writing an effective biomedical abstract is a crucial skill for medical students. A well-crafted
abstract provides a clear and concise summary of the research, highlighting its objectives,
methods, results, and conclusions. Following the key components and tips outlined in this
guide, medical students can write compelling abstracts that effectively communicate their
research findings to the scientific community.

Submitting an Abstract

Submitting abstracts to a research conference is critical in sharing your work with the broader
academic community. When submitting an abstract to a conference, several key factors should
be considered to enhance your chances of acceptance and ensure that your submission stands
out. Ensure your research aligns with the conference's themes, topics, or tracks. Tailor your
abstract to emphasize the aspects most relevant to the conference audience. Understand the
conference's target audience and write your abstract in a way that will be engaging and
informative to them. Ensure all authors have made significant contributions to the research
and reviewed and approved the abstract submission. Adhere to ethical guidelines and policies
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regarding duplicate submissions, plagiarism, and conflicts of interest. Indicate your preference
for the type of presentation (oral, poster, etc.)

Presenting Posters or Platform Talks at Conferences

Choose conferences that provide the best platform for your research. Ensure the conference’s
theme aligns with your research area. Consider the reputation and prestige of the conference
within your field—select conferences that attract researchers, clinicians, and policymakers
interested in your topic. Poster and oral (platform) presentations are two common formats for
presenting research at conferences. Posters are often suitable for preliminary or exploratory
research, while oral presentations may be better for completed studies with significant findings.
Regardless, each format has its unique characteristics, advantages, and requirements. Always
discuss submitting abstracts to conferences with your mentor.

Poster Presentations

Research is presented on a large poster, typically displayed on a board. Posters can also be
presented in a virtual manner. Make sure to follow the conference guidelines when preparing
your poster. Posters include text, figures, tables, and images to convey the research findings.
Posters are generally larger, with dimensions specified by the conference organizers. They are
designed to be visually appealing and easily read from a distance. Poster sessions allow for
direct, informal interactions between the presenter and attendees. Presenters can explain their
work in detail, answer questions, and engage in discussions with interested individuals. Posters
are usually displayed for an extended period, often throughout the conference or during a
designated poster session. Presenters typically stand by their posters for a specified period to
discuss their work with passersby. Posters attract a diverse audience, including experts,
students, and professionals from various fields. This format allows for a wide range of feedback.
An effective poster involves careful design, including layout, color schemes, and concise text.
Posters need to be printed and transported to the conference. Presenters should be prepared
to give a brief overview of their work, usually lasting a few minutes, and answer questions.

Oral Presentations

Oral presentations, sometimes referred to as platform talks or platform presentations, are
usually presented through a series of slides using software like PowerPoint, usually delivered in
a lecture-style format. Oral presentations have a defined structure, including an introduction,
methods, results, and conclusion, with each section covered in detail. Interaction is typically
limited to a brief question-and-answer session at the end of the presentation. The presenter
answers questions from the audience. The setting is often more formal than a poster session
and takes place typically in a lecture hall or conference room. Oral presentations are assigned a
specific time slot, usually ranging from 10 to 20 minutes, followed by a short Q&A period.
Presenters must adhere strictly to the allotted time to ensure the session runs smoothly. The
audience for oral presentations tends to be more focused and specific, often consisting of
individuals with a strong interest in the presented topic.
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Scope of Conferences

The scope of conferences can be categorized into local, regional, national, and international
levels, each offering distinct opportunities and challenges. Local conferences are typically
organized by medical schools, hospitals, or local medical societies and involve participants from
the immediate geographic area. They are smaller in scale, providing a more intimate setting for
networking with local professionals, faculty, and peers. Regional conferences draw attendees
from a broader geographic area, such as a group of neighboring states or a specific part of the
country. They offer broader exposure and more extensive networking opportunities compared
to local events. National conferences attract participants from across the country and are
usually organized by national medical associations or specialty societies. Presenting at a
national conference is prestigious, providing extensive networking opportunities with leading
experts and peers nationwide. International conferences involve participants from multiple
countries worldwide and are organized by international medical organizations and societies.
These conferences offer the highest level of exposure and networking on a global scale,
allowing presenters to connect with international experts and peers and gain insights into
global trends and innovations in their field. Each level of the conference offers unique benefits,
and the choice of which to attend should be based on the relevance of the conference to the
research topic, the stage of the research, networking opportunities, and logistical
considerations such as travel and costs.

Preparing a Manuscript

A well-prepared manuscript with a good research question, hypothesis, and study design
increases the chances of acceptance. Follow the journal’s submission guidelines regarding
format, structure, and referencing style. Write clearly and concisely, ensuring the introduction,
methods, results, and discussion sections are well-organized and informative. Include clear,
high-quality figures and tables that effectively present your data. Conduct a comprehensive
literature review to contextualize your findings and highlight their significance. Always work
with your mentor when preparing your manuscript.

Authorship

Authorship is a significant aspect of biomedical research, as it confers credit and accountability
for the work presented in scientific manuscripts. The criteria for authorship, the order of
authors, and the responsibilities associated with being an author are crucial for maintaining the
integrity and ethical standards of scientific research. In biomedical research, authorship should
be based on substantial contributions to the study. Often, authorship is discussed early on in
the research process with the research team. The International Committee of Medical Journal
Editors (ICMJE) provides widely accepted criteria for authorship, which include:

e Substantial contributions to conception and design, acquisition of data, or analysis and
interpretation of data

o Drafting the article or revising it critically for important intellectual content

¢ Final approval of the version to be published

e Agreement to be accountable for all aspects of the work
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All four criteria should be met for an individual to qualify as an author. Individuals who
contribute to the research but do not meet all these criteria should be acknowledged
appropriately.

Responsibilities of Authors

All manuscript authors have several key responsibilities to ensure the integrity and quality of
the research and manuscript. Authors must ensure that the data presented are accurate and
that the findings are reported honestly. Authors should disclose potential conflicts of interest
that could influence the research or its interpretation. Authors must ensure the research
adheres to ethical standards, including obtaining necessary approvals and informed consent.
Proper acknowledgment should be given to individuals who contributed to the research but do
not meet authorship criteria.

Order of Authors

The first author usually makes the most significant contribution to the research and writing of
the manuscript. For example, a student who conducted the experiments and wrote the initial
draft of the manuscript. The last author often holds a senior position, such as the principal
investigator or research supervisor, who provides overall guidance and support. Co-authors or
second author are often listed based on their relative contributions, however this is not always
true. Sometimes, these authors are listed alphabetically or based on some other structure
specified by a particular journal. In many respects any author not listed as first or last can be
seen as “middle authors.” The last author often holds a senior position, such as the principal
investigator or research supervisor, who provides overall guidance and support. Being a
corresponding author is a role of significant importance in the publication of biomedical
research. It involves a range of responsibilities, from coordinating the submission process to
ensuring compliance with ethical standards and maintaining communication post-publication.
This role is often taken by the last author.

Disputes and Issues in Authorship

Disputes over authorship can arise, and it is essential to address them transparently and fairly.
Disagreements about authorship order or inclusion should be resolved through discussion and,
if necessary, mediation by an independent party. Ghostwriting (where someone not credited
writes the manuscript) and guest authorship (where someone is credited without a significant
contribution) are unethical practices.

Publishing a Manuscript in High-Quality Journals

Selecting an appropriate journal is crucial for maximizing the impact of your research and
should be done in consultation with your research mentor and co-authors. Ensure that the
journal’s scope aligns with your research topic and that it reaches your target audience.
Consider the journal’s impact factor and reputation within the field. Higher-impact journals
often have more rigorous review processes and wider readership. Decide with your mentor
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whether to publish in an open-access journal, which can increase visibility and accessibility, or a
subscription-based journal.

Peer Review Process

Submit your manuscript through the journal’s submission system. The journal editor assigns
reviewers who are experts in your field. Address reviewers’ comments thoughtfully and
thoroughly. Revise your manuscript as needed and provide a detailed response letter explaining
how you addressed each point. Be wary of journals with no peer review or very fast peer review
turnaround times, peer review can often be a lengthy process.

Avoiding Predatory Publishers and Conferences

Predatory publishers and conferences are exploitative entities that prioritize profit over
academic integrity, often engaging in unethical practices such as charging high fees for
publication or conference participation without providing proper peer review or editorial
services. For medical students new to research, it is crucial to recognize and avoid these
predatory entities to ensure their work is disseminated in reputable and credible venues.

Characteristics of predatory publishers may include but are not limited to:
¢ Claim to offer peer review but do not conduct a rigorous or legitimate review process.
e Charge exorbitant fees without providing corresponding services.
e Use spam emails to solicit submissions, often using flattery or false claims of interest.
e Provide little or no information about their editorial board, review process, or fees.
e Use fake or misleading impact factors and other metrics to appear reputable.
¢ Websites are often unprofessional, with frequent errors and inconsistencies.

To help avoid submitting to predatory publishers, verify if the journal is indexed in reputable
databases like PubMed, Scopus, or Web of Science. Use recognized sources to check journal
impact factors and other metrics. Avoid relying on metrics provided by the journal itself without
verification. Be wary of overly flattering language that emphasizes the importance of your
work. A professional, well-maintained website with clear, detailed information about the
journal’s policies and editorial board is a good sign. Check the credibility and affiliations of the
editorial board members. Legitimate journals typically list experienced and respected
researchers. Look for valid contact information for the editorial board members and the
journal's office. Consult your institution’s library or research office for advice on selecting
reputable journals. Seek recommendations from experienced faculty members or mentors in
your field. The institutional library can also provide guidance on identifying predatory journals
and conferences.

Characteristics of predatory conferences may include but are not limited to:
e Frequent unsolicited emails and invitations to participate or speak at conferences.
o High registration and participation fees without providing adequate services or facilities.
¢ Conferences often lack a proper peer review process for submitted abstracts and papers.
¢ Organizers and sponsors may not be reputable or well-known in the field.
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e Conference details, such as schedule, speakers, and location, are often vague or subject
to frequent changes.

To avoid predatory conferences, verify if the conference is sponsored or organized by reputable
institutions or professional organizations. Look for information on previous editions of the
conference, including locations, speakers, and participants. A good sign is a professional, well-
maintained website with detailed conference agenda, speakers, and logistics information. Look
at the list of confirmed speakers. A high-quality conference typically features respected
researchers and professionals in the field.

Avoiding predatory publishers and conferences is crucial for maintaining the integrity of your
research and ensuring it reaches a credible audience. By recognizing the characteristics of
predatory entities and following the advice provided in this guide, medical students can make
informed decisions about where to submit their work and which conferences to attend.
Ensuring your research is published and presented in reputable venues protects your
reputation and contributes to advancing medical science.

Conclusion

Effective research dissemination is essential for advancing medical knowledge and practice.
Medical students can ensure that their research has a significant impact by publishing in high-
quality journals, presenting at reputable conferences, and avoiding duplication. Adhering to
best practices in research dissemination not only enhances the credibility and visibility of your
work but also contributes to the overall advancement of the scientific community.
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HOW TO PUT TOGETHER A CV

A Curriculum Vitae (CV) is a comprehensive document that outlines an individual's educational
background, professional experience, skills, and accomplishments. It is typically used to apply
for academic, research, and high-level professional positions, providing a detailed overview of
one's qualifications and career trajectory. Creating a CV specifically for reaching out to a
potential research mentor involves highlighting your academic achievements, research
experience, and relevant skills. Keep in mind that the flow and content of a CV will be
customized to emphasize relevant technical skills, research experience, and academic
achievements relevant to the type of research project or lab you are applying to, ensuring that
the most pertinent qualifications and accomplishments are prominently featured.

Contact Information

Name: Full name at the top in bold.

Phone Number: Your primary contact number.
Email: A professional email address.

Professional Summary

A professional summary is a brief section in a CV that highlights your key qualifications,
experiences, and skills relevant to the job you are applying for. It serves as a snapshot of your
professional profile and helps potential employers quickly understand your background and
value.

Summary of Qualifications

A summary of qualifications in a CV is a concise, bullet-pointed section highlighting your most
relevant skills, experiences, and accomplishments. It is designed to quickly demonstrate your
suitability for the job. Here's what typically is included in a summary of qualifications:

e Key Skills and Competencies: Highlight the most relevant skills and competencies that
align with the job you’re applying for.

e Years of Experience: Indicate the amount of experience you have in relevant roles or
industries.

e Major Achievements: Mention significant achievements or accomplishments in previous
roles, particularly those that had a measurable impact.

e Technical Skills: Include specific technical skills or proficiencies with tools, software, or
technologies relevant to the job.

e Certifications and Training: List any relevant certifications, training, or professional
development courses that add to your qualifications.

e Languages: Mention any language proficiencies if they are relevant to the position.

e Education Highlights: Include notable academic achievements or relevant coursework if
applicable.
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Education
Medical School: Name of your medical school, location, degree pursued (e.g., MD, DO),
and expected graduation date.
Undergraduate Education: Name of the undergraduate institution, location, degree
received, and graduation date.
Other Relevant Education: Any other relevant education, such as additional degrees or
certifications.

Research Experience
Research Projects: Title of the project, your role, the institution, dates, and a brief
description of your contributions and findings.
Publications: Full citations of any published papers, abstracts, or posters.
Presentations: Any presentations at conferences or academic meetings.

Clinical Experience
Rotations and Clerkships: Details about your clinical rotations, including specialty,
institution, dates, and any notable achievements or skills acquired.
Volunteer Clinical Work: Any volunteer clinical experiences, including the setting, your
role, and dates.

Work Experience
Relevant Work: Any work experience relevant to medicine, including job title, employer,
location, dates, and a brief description of your duties.
Other Work Experience: Any other work experience that has helped develop
transferable skills (e.g., communication, teamwork).

Leadership and Extracurricular Activities
Leadership Roles: Any leadership positions held in student organizations, including title,
organization, dates, and responsibilities.
Volunteer Activities: Description of any volunteer work, including the organization, your
role, and dates.
Professional Memberships: Membership in medical or professional organizations.

Honors and Awards
Academic Honors: Any academic honors or awards received, including the name of the
award, the awarding body, and the date.
Scholarships: Any scholarships awarded, including the name of the scholarship, the
awarding body, and the date.
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Skills
Clinical Skills: List specific clinical skills you have acquired.
Languages: Any languages spoken and proficiency levels.
Technical Skills: Relevant technical skills, such as proficiency with medical software or
research tools.

Media Contributions

The media contribution section of a CV highlights your involvement and recognition in various
media outlets. This can include articles, interviews, guest appearances, podcasts, or
contributions to industry publications. It demonstrates your expertise and visibility in your field,
showcasing how your insights and work have been featured or acknowledged in the media.

Certifications and Licenses

List any relevant certifications, such as BLS (Basic Life Support), ACLS (Advanced Cardiovascular
Life Support), etc. Here is the section to include any medical licenses you hold. Be sure to
include the issuing body and date.

References
Include the names, titles, and contact information for a few professional references (typically 3-
5). Make sure to ask for their permission first.

Tips for a Strong CV

Emphasize your accomplishments and skills relevant to the position or tailor your CV to align
with the research interests of the mentor you are contacting. Use bullet points and concise
language to make your CV easy to read. Ensure there are no spelling or grammatical errors.
Regularly review your CV to remove redundant information and ensure each section is clear
and distinct. Ask colleagues or mentors to review your CV to catch any instances of double
dipping and provide feedback on clarity and organization.

Avoid double dipping, in the context of academic research and presentations, double dipping
on a CV refers to the practice of listing the same presentation, paper, or research project
multiple times in different sections. This can make it seem like you have more accomplishments
than you actually do and can be viewed negatively by potential employers or academic
committees. Listing an accepted abstract and an associated publication is acceptable, but avoid
listing the same iteration of a presentation multiple times. Remember, presentations at
conferences should be unique presentations for that conference, it is common to present
preliminary findings at a smaller, regional conference and then present updated, more
comprehensive results at a larger, international conference, but you should not present the
exact same abstract with no updates or changes at two conferences that have overlapping
audiences and listing it on your CV.
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There is an example CV template provided granted there is no definitive structure. Regardless
make sure that your CV is consistently formatted, making it easy for readers to navigate and
find relevant information.

Additional Tips

Accompany your CV with a personalized cover letter expressing your interest in their research
and how your background aligns with their work.

Sample CV Template

John Doe
(123) 456-7890
john.doe@example.com

PROFESSIONAL SUMMARY:

Dedicated and highly motivated medical student with a strong passion for biomedical research
and clinical studies. Possesses a solid foundation in medical knowledge and a keen interest in
exploring innovative solutions to healthcare challenges. Demonstrates excellent analytical skills,
attention to detail, and a commitment to advancing medical science through rigorous research.
Seeking opportunities to contribute to cutting-edge research projects and collaborate with
leading experts in the field.

SUMMARY OF QUALIFICATIONS

e Pursuing a Doctor of Medicine (MD) degree with a comprehensive understanding of
medical sciences, human anatomy, physiology, pathology, and pharmacology.

e Hands-on experience in conducting laboratory experiments, data collection, and
analysis. Successfully completed several research projects during medical school,
focusing on areas such as oncology, cardiology, and infectious diseases.

e Proficient in various laboratory techniques, including PCR, ELISA, cell culture, and
microscopy. Skilled in using statistical software (SPSS, R) for data analysis and
interpretation.

e Consistently achieved high academic performance, demonstrating a strong grasp of
medical concepts and research methodologies. Recipient of multiple academic awards
and scholarships.

EDUCATION
e XYZ Medical School, City, State
e Doctor of Medicine (MD), Expected Graduation: May 2025
e ABC University, City, State
e Bachelor of Science in Biology, Graduated: May 2021
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RELEVANT COURSEWORK

- Advanced Research Methods

- Epidemiology and Public Health
- Biostatistics

RESEARCH EXPERIENCE

Research Assistant, XYZ Medical School, City, State

June 2022 — Present

- Conducted research on the effects of drug X on Y disease.
- Published findings in the Journal of Medical Research.

PUBLICATIONS
e Doe, J.,, & Smith, A. (2023). Title of the research paper. Journal of Medical Research,
12(3), 123-130.
e Doe, J.,, & Smith, A. (2023). Title of the research paper. Journal of Medical Research,
12(3), 123-130.
e Doe, J.,, & Smith, A. (2023). Title of the research paper. Journal of Medical Research,
12(3), 123-130.

PRESENTATIONS & ABSTRACTS
e Doe, J. (2023). Title of the presentation. Conference on Medical Research, City, State.
e Doe, J. (2023). Title of the presentation. Conference on Medical Research, City, State.
e Doe, J. (2023). Title of the presentation. Conference on Medical Research, City, State.

CLINICAL EXPERIENCE
Internal Medicine Clerkship, XYZ Hospital, City, State
Jan 2023 — March 2023
e Assisted in patient care, conducted patient interviews, and performed physical exams.

WORK EXPERIENCE
Medical Scribe, ABC Clinic, City, State
May 2021 — May 2022
e Documented patient encounters and assisted with administrative tasks.

LEADERSHIP AND EXTRACURRICULAR ACTIVITIES
President, Medical Students Association, XYZ Medical School
Sept 2022 — Present
e Organized events and led initiatives to support medical students.

HONORS AND AWARDS
Dean’s List, XYZ Medical School, 2022
e Awarded for academic excellence.
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SKILLS
e Research: Data analysis, lab techniques, SPSS, R
e (linical: Patient interviews, physical exams
e Languages: English (native), Spanish (proficient)

MEDIA CONTRIBUTIONS

e Guest Speaker on "Medical Innovations" Podcast (March 2024): Discussed the latest
advancements in biomedical research and shared insights from personal research
projects on cardiovascular diseases.

e Article Contributor, MedStudent Journal (January 2024): Wrote an article titled "The
Future of Personalized Medicine: Opportunities and Challenges," exploring the impact of
genomic research on patient care.

e Panelist on Local News Segment (October 2023): Participated in a panel discussion on
the importance of clinical trials and research in developing new treatments for rare
diseases.

¢ Interviewed for University News (June 2023): Featured in an article about emerging
researchers, highlighting my work on innovative cancer treatment strategies.

CERTIFICATIONS AND LICENSES
e BLS (Basic Life Support), American Heart Association, 2023
e ACLS (Advanced Cardiovascular Life Support), American Heart Association, 2023

REFERENCES

Perry Cox, MD

Professor of Medicine

Department of Internal Medicine

Sacred Heart Teaching Hospital

Email: perry_cox@sacredhearthospital.org
Phone: (XXX) XXX-XXXX

Professor Charles Xavier

Professor of Biological Anthropology
Xavier Institute

Email: professorX@Xaviorinstitute.edu
Phone: (XXX) XXX-XXXX

Gregory House, MD

Professor of Medicine, MD
Department of Diagnostics
Princeton-Plainsboro Teaching Hospital
Greg.house@PPTH.edu

Phone: (XXX) XXX-XXXX
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APPENDIX

In this section, you will find appended versions of detailed guidelines and grading rubrics (when
applicable) for each aspect of the SARP course that you will be responsible for completing
during SARP. Please note these guidelines can also be found with the course syllabus and on the
SARP Website on the Texas Tech Health El Paso Foster School of Medicine Department of
Medical Education Website. Please use these resources to help you put together your required
course components.
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Project Plan and Grading Rubric

Guidelines for the SARP Course Project Plan (PSAP 5401)

The Project Plan is a submission to fulfill the first credit of the three credit SARP Course
requirement. The Project Plan must be developed with the help of your SARP Course project
mentor and needs to describe your project in enough detail to allow a reviewer of the
document a clear understanding of your research question or hypothesis, the specific aims of
the project, what methods you will use to address these aims, what data, or information you
will acquire and what analytic approaches you plan to use. Further, a detailed timeline of the
project needs to be included.

Project Plan Points of Emphasis

For access to the SARP Syllabus, Guidelines, and additional information, please visit
the SARP Website.

If you have any questions or concerns about your SARP Course Project Plan, don’t
hesitate to contact the SARP Course Faculty Co-Directors or the SARP Director.

Your SARP Course project mentor is responsible for helping you develop your project
in all its aspects. Work proactively to develop a solid working relationship with your
mentor to maximize both the success of your project and your professional
development.

It is essential to engage in conversations with mentors before including them in the
Project Plan.

The Project Plan needs to be authored by you, representing original work. You must
take ownership of the Project Plan and be responsible for its content.

Group projects are allowed (with up to 5 students working with a single mentor);
however, each student should clearly identify a unique research question or
hypothesis that can distinguish their contribution and provide for an independent
Project Plan, Final Report, and Poster presentation, in fulfillment of the SARP Course
credits.

The SARP Course is designed to provide scholarship / research to enhance your
medical school experience, and credit will be given for work done while you are
enrolled at the FSOM. Scholarship or research pursued before matriculating to the
FSOM cannot be used directly in fulfillment of the SARP Course requirement;
however, continuing work on earlier projects, potentially continuing work with a
previous mentor, is allowed if you clearly document how your SARP Course activities
are extensions of such previous work.

Please note that case studies or narrative reviews are not considered sufficient to
meet the SARP Course Project requirement. However, meta-analysis or systematic
reviews are acceptable. For information on different types of scientific reviews,
please see this helpful publication: A typology of reviews: an analysis of 14 review
types and associated methodologies.
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e An excellent resource to become familiar with is the AMA Style Manual, which
provides comprehensive guidelines for preparing uniform technical documents. A full
PDF version is available: https://authorservices.wiley.com/asset/Wiley-AMA-Style-
Manual.pdf

e Your Project Plan must be submitted electronically. You will receive emails reminding
you of this deadline. Your SARP project mentor will receive a notification requiring
acknowledgement of their mentoring responsibility.

e For those with external mentors, students must have permission to present external
work at the SARP symposium.

Project Plan Contents

Your SARP Course Project Plan should contain the following elements:
e Title of Project, a concise sentence or phrase to describe the overall project.
e Mentor name and contact information

Be certain to work closely with your mentor on developing your Project Plan. Your mentor will
formally sign-off on this document through the REDCap software.

Project Background and Significance

This should be a concise introduction to the topic of your project and include citations of
primary literature to support the development of your ideas, providing a logical foundation for
your research question or hypothesis.

Research Question or Hypothesis
This is a one sentence statement of the project’s overall focus as an explicit research question
or hypothesis to be addressed.

Specific Aims with Rationale

The Specific Aims should be a small set of concise one- or two-sentence summaries of what you
expect to achieve in executing your SARP Course project. A short paragraph should accompany
each Specific Aim to provide a rationale for how the Aim addresses the project’s research
guestion or hypothesis.

Methods
This will be a short description of the methods (employing techniques, materials, databases,
surveys, etc.) you intend to use to directly accomplish your Specific Aims.

Analysis
This section describes the methods you will use to analyze your data. For basic research and

community / epidemiology projects, this could include a description of the statistical methods
to be employed. For a medical humanities or ethics project, this might involve narrative or
reflective analysis.
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Compliance

If your SARP Course project requires compliance approval for using human subjects (IRB),
animals (IACUC), or biohazardous materials (IBC), it is your responsibility to work with your
mentor to document these in your Project Plan and clearly describe what compliance is in
place or the schedule for obtaining compliance. Please note no data collection should occur
without compliance documentation being approved by the institution.

Timeline

Provide a timeline for executing your SARP Course project and when you expect to submit your
Final Report. There are 3 tracks to complete your SARP Course project: choose one for creating
a timeline for this Project Plan document. However, you can change your Track, if necessary, by
submitting a Progress Report. For example, if you submit your Project Plan expecting to
complete your SARP Course by Track 1, you can change to Track 2 by submitting a Progress
Report on the due date for the Track 1 Final Report. The diagram below outlines the three
available Tracks and schedules:

SARP Completion Tracks

AY 2 AY 3 AY 4
|| i |

CITI Training Flnal
OI Tranin
TraCk 1 Project Plan_ Reort
Develo [Develop=

a research question or interest

a research mentor
Re ne project plan

| xecute=> project

CIm Training | Progress Final
COI Traning Poster
Project Plan. Re ort Report

Develo IDevelop= a research question or interest

Track 2:

a research mentor

-m prOJect plan

Execute project

CITI Training PI'OI'ESS Proress Final Post
COI Traning S oster
proiectplan | ReEDOIt Report Report | —

Develo [Develop= a research question or interest

Track 3:

a research mentor

| Refiné project plan
I

Execute= project

Figure 1

Additional considerations for developing your Project Plan:
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e Your Project Plan will be assessed by a faculty member using a grading rubric
available in the SARP Syllabus. Review this assessment rubric so you’re familiar with
how elements of your Project Plan will be graded.

e Be certain to work closely with your mentor on project planning and obtain and
incorporate feedback on all drafts and the submitted Project Plan.

e Provide relevant citations and a bibliography using the format suggested in the AMA
Style Manual.

Be certain to read the cited references so the Project Plan has scholarly integrity.
e Edit your Project Plan carefully:

o Proofread (suggestion: have a naive reader look at your final draft).

o Check spelling

o Check grammar: punctuation, sentence structure, subject-verb agreement
(plural or singular), tense consistency, etc.

o Be certain your SARP Course project mentor is actively involved in this
process.

e If you are accepted to a summer research program that does not provide explicit
information about your mentor or project, work with the program directors so you
can submit a ‘placeholder’ Project Plan by the deadline and propose a date you will
submit a complete Project Plan.

Integrity Issues

e Students are required to demonstrate a high level of intellectual and personal
integrity during all activities related to completion of the SARP Course, in alighnment
with their professional identity formation as physicians. This includes communicating
clearly and honestly and treating all staff, students, faculty and other participants
with respect and dignity.

e \Write your own reports. Do not plagiarize, and if significant content derives from
published materials, cite appropriately. ChatGPT or other Artificial Intelligence-
derived content used in any component of your submitted assignments for the SARP
Course must be clearly identified.

Submitting the SARP Course Project Plan:
In addition to the Project Plan contents described, your Project Plan requires a Cover Page that
includes the following information and format:

e Heading: SARP Course Project Plan

e Student name and R-number

e Expected graduation class (e.g., C2028)

e Student email address

e Date

e Title of SARP Course project

e Mentor name and affiliation
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e Mentor email address
e Expected completion date for the SARP Course (i.e., choose Track 1, 2, or 3).

The entire Project Plan document, including a Cover Page needs to be submitted electronically.
Instructions for submission will be available through emails and on the SARP Website. Please
use the following format for naming the submitted Project Plan PDF:

Last name_First name_C2027_Project_Plan_04.15.2025

Your Project Plan must be submitted electronically. You will receive emails reminding you of
this deadline. Your SARP project mentor will receive a notification requiring acknowledgement
of their mentoring responsibility.

Grading of the SARP Course Project Plan

The SARP Course Project Plan will first be triaged by the SARP Director to assure that all
required textual elements are included; if not, the student will be notified and allowed a 3-day
grace period to resubmit a complete Project Plan; if not submitted by this deadline students will
meet with the SARP Faculty Co-Directors and their College Mentor to discuss the situation,
along with a notation in their SARP Professionalism Report. Following grading by a FSOM faculty
reviewer using a grading rubric (available in the SARP Syllabus and on the SARP Website) a Pass
or Not-Yet-Pass determination will be made. If Pass, the grading rubric will be deposited in the
individual student’s ePortfolio. If Not-Yet-Pass, the student will be contacted by email, the
grading rubric included, and provided 2 weeks to revise and resubmit the Project Plan. The
revised Project Plan will be re-reviewed by the original reviewer and the SARP Faculty Co-
Directors. If Pass, the grading rubric for the revised Project Plan will be deposited in the
individual student’s ePortfolio. If Not-Yet-Pass, the student will receive a grade of ‘FA’ (Fail) on
their official transcript for PSAP 5401 and will be referred to the Committee on Student Grading
and Promotion (GPC).

SARP Course Objectives for Project Plan:
The following SARP Course Objectives are addressed by completing the SARP Course Project
Plan:

o Objective 1: Students will develop a research question or project theme, identify a
faculty mentor, and complete all requirements for the SARP Course.

o Objective 2: Students will learn how to search the literature, identifying previous
knowledge and theory that provides context and relevance for their project.

o Objective 3: Students will submit a Project Plan, including a research question or
hypothesis, specific aims, rationale, methods, analysis, and timeline.

o Objective 4: Students will choose and employ adequate methods for the acquisition
and statistical analysis of data and information for their project.

o Objective 6: Students will demonstrate clear and effective communication skills (oral
and written) in the presentation of their project.

o Objective 7: Students will learn about protection of human and animal subjects
involved in research.
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Objective 8: Students will learn and exhibit ethical principles in the design and
execution of their projects.

Objective 9: Students will exhibit attitudes and behaviors consistent with
professional conduct of research and scholarship.

Objective 10: Students will submit each assignment by the deadline and respond to
all communications and feedback in a timely and professional matter.

Objective 11: Students will collaborate generously and professionally with their
mentor, faculty, students, and staff during completion of their research project.
Objective 12: Students will learn principles of self-directed and life-long learning and
apply these to the design and execution of their projects.

Objective 13: Students will learn the principles of self-efficacy, monitoring and
sharing personal progress through self-evaluation and reflection, and SARP Course
evaluation.
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SARP Project Plan Assessment Rubric

Reviewer Grading Rubric for SARP Course Project Plan

Instructions for Reviewer: Please use the following category descriptors to give the
student feedback on the quality of his/her project. This rubric is meant to provide the
student with a feel for how well they did relative to both their peers and your
expectations for a project at this stage of their career. Additionally, please provide
narrative feedback regarding the strengths of the project plan as well as any areas
where you see potential for improvement.

Student Name:

Student Mentor:

Project Title:

Project Background and Significance

Needs Improvement

The project theme or significance is missing or poorly defined.
Supporting evidence from the literature is missing or
inadequate, failing to provide relevant background
information or context.

Satisfactory

The project theme or significance is present but lacks clarity or
specificity. Supporting evidence from the literature is present
but may lack depth or fails to address key sources or
perspectives.

Excellent

The project theme or significance is clearly defined, focused,
and demonstrates originality and relevance to the field of
study. Supporting evidence from the literature is
comprehensive, demonstrating a thorough understanding of
existing knowledge in the field and critically analyzing relevant
sources.

Research Question or Hypothesis

Needs Improvement

The research question or hypothesis is missing or poorly
defined. Supporting evidence from the literature is missing or
inadequate, failing to provide relevant background
information or context.

Satisfactory

The research question or hypothesis is present but lacks
clarity or specificity.

Excellent

The research question or hypothesis is clearly defined,
focused, and demonstrates originality and relevance to the
field of study.

Rationale and Specific Aims

Needs Improvement

The rationale for the research or project aims are weak or
unclear, lacking justification for significance or relevance.

Satisfactory

The rationale for the research or project aims is somewhat
clear but lacks strong justification or fails to link aims to the
research question or project theme.
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Excellent

The rationale for the research or project aims is well-justified,
logically presented, and convincingly argues for the
importance and relevance of the proposed work.

Project Design and Methods

Needs Improvement

The project design is missing or poorly described, lacking key
components or not aligned with the research question or
project aims.

Satisfactory

The project design is present but lacks some details.

Excellent

The project design is clear, well-structured, and demonstrates
a comprehensive understanding of the research methods and
procedures necessary to address the research question or
project aims.

Analysis Plan

Needs Improvement

The analysis plan is missing or insufficiently described, lacking
clarity or failing to align with the research question or project
aims.

Satisfactory

The analysis plan is present but lacks detail or fails to explain
the appropriate statistical or analytical methods.

Excellent

The analysis plan is well-defined, appropriate for the research
guestion or project aims, and demonstrates a sound
understanding of statistical or analytical methods.

Writing

Needs Improvement

The proposal is poorly written, containing numerous
grammatical errors, lack of organization, and incoherent
structure. Citations are non-existent or inconsistently
formatted, or inappropriate.

Satisfactory

The proposal is generally well-written but contains some
grammatical or structural issues that affect clarity or
readability. Citations present and appropriate with mostly
consistent formatting.

Excellent

The proposal is well-written, clear, and effectively
communicates the research question or project aims,
methods, rationale, and findings. Citations present and
appropriate with consistent formatting.

Overall Project Plan

Needs Improvement

There are significant concerns regarding the quality of this
project plan. There are significant concerns regarding the
research and academic integrity, including potential ethical
issues

Satisfactory

The project plan provides sufficient information but there are
minor concerns or oversights. The proposal demonstrates
awareness of research and academic integrity, but there are
minor concerns or oversights.

SCHOLARLY ACTIVITY AND RESEARCH PROGRAM STUDENT HANDBOOK
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Excellent

The project plan is well-justified, logical, and convincingly
presented effectively communicating all aspects of the plan.
The proposal shows a strong commitment to research and
academic integrity, including appropriate ethical
considerations, transparent data collection and analysis, and
accurate and consistent citations.

If a reviewer classifies your overall Project Plan as “needs improvement” consult with

your project mentor to revise your Project Plan based on the reviewer provided
feedback.

Reviewer Comments:
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Final Report and Grading Rubric

Guidelines for the SARP Course Final Report (PSAP 6401)

The Final Report is a submission to fulfill the second credit of the SARP Course requirement. The
Final Report must be developed with the help of your SARP Course project mentor and needs to
describe the results of your project in enough detail to allow a reviewer of the document a clear
understanding of your research question or hypothesis, the Specific Aims of the project, what
methods you used to address these aims, what data, or information you acquired and what
analytic approaches you used. Finally, a concise description of conclusions, limitations, and
possible further work for the project needs to be included.

Final Report Points of Emphasis

e For access to the SARP Syllabus, Guidelines, and additional information, please visit
the SARP Website.

e If you have any questions or concerns about your SARP Course Final Report, don’t
hesitate to contact the SARP Course Faculty Co-Directors or the SARP Director.

e Your SARP Course project mentor is responsible for helping you develop your Final
Report. Work proactively with your mentor to maximize both the quality of the Final
Report and your professional development.

e The Final Report must be authored by you, representing original work. You need to
take ownership of the Final Report and are responsible for its content. Do not simply
copy and paste a published manuscript.

e Refer to the AMA Style Manual, which provides comprehensive guidelines for
preparing uniform technical documents. A full PDF version is available:

e Your Final Report must be submitted electronically. You will receive emails reminding
you of this deadline. Your SARP project mentor will receive a notification requiring
acknowledgement of their mentoring responsibility.

Final Report Contents

Your SARP Course Final Report should contain the following elements:
e Title of Project
e Mentor name and contact information

Be sure to work closely with your mentor on developing your Project Plan. Your mentor will
formally sign-off on this document through the REDCap software.

Project Background and Significance

This should be a concise introduction to the topic of your project and include citations of
primary literature to support the development of your ideas, providing a logical foundation for
your research question or hypothesis.

Research Question or Hypothesis
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This is a one sentence statement of the project’s overall focus as an explicit research question
or hypothesis to be addressed.

Specific Aims with Rationale

The Specific Aims should be a small set of concise one- or two-sentence summaries of what you
expect to achieve in executing your SARP Course project. A short paragraph should accompany
each Specific Aim to provide a rationale for how the Aim addresses the project’s research
guestion or hypothesis.

Methods

This will be a short description of the methods (employing techniques, materials, databases,
surveys, etc.) you intend to use to directly accomplish your Specific Aims. This section will also
describe the methods you used to analyze your data.

Results
The results section includes the relevant findings of your SARP Course Project. This section
consists of your figures with appropriate captions and tables.

Discussion
The discussion portion of your Final Report explores the implications, significance, and context
of the research findings. Below is a list of topics often included in a discussion:

e Interpretation of Results: This is the core of the Discussion section. It involves
interpreting what the results mean in the context of the study's hypotheses or
research question. This may include explaining how the findings support or
contradict previous studies or theories.

e Contextualization with Previous Research: The findings should be compared with
the relevant literature. For example, discussing how the results align with, extend, or
challenge existing knowledge in the field.

e Explaining Unexpected Results: If there were any surprising or unexpected findings,
these should be addressed. The discussion might explore possible reasons for these
results and how they fit into the broader context of the field.

e Limitations of the Study: Every study has limitations, and these should be honestly
and clearly stated. This may include methodological limitations, constraints on
generalizability, or potential sources of bias.

e Implications of the Findings: Discuss the implications of the results for the field,
practice, policy, or future research. This is where the broader impact of the research
is explored.

e Suggestions for Future Research: Based on the findings and limitations, the
Discussion should suggest areas for further study. This helps to set the stage for
future work in the field.

e Theoretical and Practical Relevance: If applicable, discuss how the findings
contribute to the theoretical understanding of the topic and any practical
applications of the research.
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Conclusions
Summarize any conclusions you were able to make. Also comment on any limitations of your
study and how your work could be extended.

Compliance
Attach any compliance documents (IBC, IACUC, IRB — exempt or non-exempt) to the assignment
submission portal.

Student contribution to the project

Include a brief description of your involvement in all aspects of the project and what
contributions were provided by others.

Additional considerations for developing your Final Report:

Your Final Report will be assessed by a faculty member using a grading rubric
available in the SARP Syllabus. Review this assessment rubric so you’re familiar with
how elements of your Final Report will be graded.
Be certain to work closely with your mentor on project planning and obtain and
incorporate feedback on all drafts and the submitted Final Report.
Provide relevant citations and a bibliography using the format suggested in the AMA
Style Manual.
Be certain to read the cited references so the Final Report has scholarly integrity.
Edit your Final Report carefully:
o Proofread (suggestion: have a naive reader look at your final draft).
o Check spelling.
o Check grammar: punctuation, sentence structure, subject-verb agreement
(plural or singular), tense consistency, etc.
o Be certain your SARP Course project mentor is actively involved in this
process.

Integrity Issues

Students are required to demonstrate a high level of intellectual and personal
integrity during all activities related to completing the SARP Course, in alignment
with forming their professional identity as physicians. This includes communicating
clearly and honestly and treating all staff, students, faculty, and other participants
with respect and dignity.

Write your own reports. Do not plagiarize, and if significant content derives from
published materials, cite appropriately. ChatGPT or other Artificial Intelligence-
derived content used in any component of your submitted assignments for the SARP
Course must be clearly identified.

Submitting the SARP Course Final Report:
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In addition to the Final Report contents described, your Final Report requires a Cover Page that
includes the following information and format:

e Heading: SARP Course Final Report

e Student name and R-number

e Expected graduation class (e.g., C2027)

e Student email address

e Date

e Title of SARP Course project

e Mentor name and affiliation

e Mentor email address

The entire Final Report document, including a Cover Page, needs to be submitted electronically.
Instructions for submission will be available through emails and on the SARP Website. Please
use the following format for naming the submitted Final Report PDF:

Last name_First name_C2027_Final_Report_10.18.2024

Your Final Report must be submitted electronically. You will receive emails reminding you of
this deadline. Your SARP project mentor will receive a notification requiring acknowledgement
of their mentoring responsibility.

Grading of the SARP Course Final Report

The SARP Course Final Report will first be triaged by the SARP Director to assure that all
required textual elements are included; if not, the student will be notified and allowed a 3-day
grace period to resubmit a complete Final Report. Following grading by an FSOM faculty
reviewer using a grading rubric (available in the SARP Syllabus and on the SARP Website) a Pass
or Not-Yet-Pass determination will be made. If Pass, the grading rubric will be deposited in the
individual student’s ePortfolio. If Not-Yet-Pass, the student will be contacted by email, the
grading rubric included and provided 2 weeks to revise and resubmit the Final Report. The
revised Final Report will be re-reviewed by the original reviewer and the SARP Faculty Co-
Directors. If Pass, the grading rubric for the revised Final Report will be deposited in the
individual student’s ePortfolio. If Not-Yet-Pass, the student will receive a grade of ‘FA’ (Fail) on
their official transcript for PSAP 6401 and will be referred to the Committee on Student Grading
and Promotion (GPC)..

SARP Course Objectives for the Final Report
The following SARP Course Objectives are addressed by completing the SARP Course Final
Report:
o Objective 1: Students will develop a research question or project theme, identify a
faculty mentor, and complete all requirements for the SARP Course.
o Objective 2: Students will learn how to search the literature, identifying previous
knowledge and theory that provides context and relevance for their project.
o Objective 4: Students will choose and employ adequate methods for the acquisition
and statistical analysis of data and information for their project.
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Objective 5: Students will submit a Final Report of their project, providing a concise
summary of the project execution, data acquisition and analysis, and conclusions.
Objective 6: Students will demonstrate clear and effective communication skills (oral
and written) in the presentation of their project.

Objective 7: Students will learn about protection of human and animal subjects
involved in research.

Objective 8: Students will learn and exhibit ethical principles in the design and
execution of their projects.

Objective 9: Students will exhibit attitudes and behaviors consistent with
professional conduct of research and scholarship.

Objective 10: Students will submit each assignment by the deadline and respond to
all communications and feedback in a timely and professional matter.

Objective 11: Students will collaborate generously and professionally with their
mentor, faculty, students, and staff during completion of their research project.
Objective 12: Students will learn principles of self-directed and life-long learning and
apply these to the design and execution of their projects.

Objective 13: Students will learn the principles of self-efficacy, monitoring and
sharing personal progress through self-evaluation and reflection, and SARP Course
evaluation.
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SARP Final Report Assessment Rubric

Reviewer Grading Rubric for SARP Course Project Final Report

Instructions for Reviewer: Please use the following category descriptors to give
the student feedback on the quality of his/her project. This rubric is meant to
provide the student with a feel for how well they did relative to both their peers

and your expectations for a project at this stage of their career. Additionally,
please provide narrative feedback regarding the strengths of the final project
report as well as any areas where you see potential for improvement.

Student Name:

Student Mentor:

Project Title:

Research Question or Project Theme

Needs
Improvement

The research question or project theme is missing or poorly
defined.

Satisfactory

The research question or project theme is present but lacks
clarity or specificity.

The research question or project theme is clearly defined,

Excellent focused, and demonstrates originality and relevance to the field
of study.
Literature Review
Needs The literature review is missing or inadequate, failing to provide
Improvement | relevant background information or context.

Satisfactory

The literature review is present but lacks depth or fails to address
key sources or perspectives

The literature review is comprehensive, demonstrating a

Excellent thorough understanding of existing knowledge in the field and
critically analyzing relevant sources.
Rationale and Specific Aims
Needs The rationale for the research or project aims is weak or unclear,
Improvement | lacking justification for its significance or relevance.

Satisfactory

The rationale for the research or project aims is somewhat clear
but lacks strong justification or fails to link aims to the research
guestion or project theme.

The rationale for the research or project aims is well-justified,

Excellent logically presented, and convincingly argues for the importance
and relevance of the proposed work.
Project Design
Needs The project design is missing or poorly described, lacking key
components or not aligned with the research question or project
Improvement

aims.

Satisfactory

The project design is present but lacks detail or coherence,
missing important information or failing to address potential
limitations.
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The project design is clear, well-structured, and demonstrates a
comprehensive understanding of the research methods and

Excellent . .
procedures necessary to address the research question or project
aims.

Analysis
Needs The analysis is missing or insufficiently described, lacking clarity
Improvement | or failing to align with the research question or project aims.

Satisfactory

The analysis is present but lacks detail or fails to explain the
appropriate statistical or analytical methods.

The analysis is well-defined, appropriate for the research

Excellent guestion or project aims, and demonstrates a sound
understanding of statistical or analytical methods.
Writing
Needs The final report is poorly written, containing numerous
grammatical errors, lack of organization, and incoherent
Improvement

structure.

Satisfactory

The final report is generally well-written but contains some
grammatical or structural issues that affect clarity or readability.

The final report is well-written, clear, and effectively

Excellent communicates the research question or project aims, methods,
rationale, and findings.
Research and Academic Integrity
Needs There are significant concerns regarding the final report research
and academic integrity, including potential ethical issues, lack of
Improvement

transparency, or improper citation practices.

Satisfactory

The final report demonstrates awareness of research and
academic integrity, but there are minor concerns or oversights.

The final report shows a strong commitment to research and
academic integrity, including appropriate ethical considerations,

Excellent ) .
transparent data collection and analysis, and accurate and
consistent citations.
Overall Project Final Report
Needs There are significant concerns regarding the quality of this final
report. There are significant concerns regarding the research and
Improvement

academic integrity, including potential ethical issues

Satisfactory

The final report provides sufficient information but there are
minor concerns or oversights. The report demonstrates
awareness of research and academic integrity, but there are
minor concerns or oversights.

Excellent

The final report is well-justified, logical, and convincingly
presented effectively communicating all aspects of the plan. The
report shows a strong commitment to research and academic
integrity, including appropriate ethical considerations,
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transparent data collection and analysis, and accurate and
consistent citations.

If a reviewer classifies your overall Final Report as “needs improvement” consult
with your project mentor to revise your Final Report based on the reviewer
provided feedback.

Reviewer Comments:
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Poster Presentation and Grading Rubric

Guidelines for the Poster Presentation (PSAP 7401)

The Poster Presentation is the final credit of the three-credit SARP Course requirement. The
Poster Presentation must be developed with the help of your SARP project mentor. The Poster
Presentation is the capstone element of your SARP Course Project and should be a concise
summary of your research question or hypothesis, the specific aims of the project, what
methods you used to address these aims, your project’s results, conclusions, and ethical
statement.

Poster Presentation Points of Emphasis

e Your SARP Course project mentor is responsible for helping you develop your Poster
Presentation in all its aspects. Work proactively to develop a solid working
relationship with your mentor to maximize both the success of your project and
your professional development.

e The Poster Presentation needs to be created by you, representing original work. You
need to take ownership of the Poster Presentation and are responsible for its
content. This needs to be a new poster created specifically for the SARP Symposium.

e Your Poster Presentation will be presented at the SARP Symposium and will be
assessed by several reviewers according to the Poster Presentation rubric available
on the_ SARP Website, in the Appendix and also on Elentra.

e Your poster will be presented digitally (as a PowerPoint slide) at the Annual SARP
Symposium. Poster templates are available from the Texas Tech Health El Paso Office
of Institutional Advancement.

Poster Contents
Your SARP Course Poster should contain the following elements:
e Title of Project
e Author List and affiliations
o Please list all authors and the respective affiliations that participated in
your SARP Course Project. By convention as presenter, you should be
listed as first author, and your mentor should be listed as the final author.

Abstract

The poster abstract contains text (no figures or tables) and appears at the beginning of the
poster. The abstract is typically between 200-300 words in length. References should be
omitted in the abstract and abbreviations should be avoided.

Background/Introduction
This should be a concise introduction to the topic of your project providing a logical foundation
for your hypothesis or research question.

Hypothesis or Research Question
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This is a one sentence statement of the project’s overall focus stated as an explicit hypothesis,
or a specific research question to be addressed.

Specific Aims with Rationale
The specific aims should be concise one- or two-sentence summaries of what you expected to
achieve in executing your project.

Materials and Methods

This will be a short description of the methods (employing techniques, materials, databases,
surveys, etc.) you used to directly accomplish your Specific Aims. Graphical representations of
your methods or workflow may take some effort to design but it will save you space and are
often more visually appealing.

Results

This section is where you will include the relevant findings of your SARP Course Project. This
section should include your figures with appropriate captions and tables. Remember that
figures are usually more appealing than tables and tables although often appropriate can be
difficult to read at a distance.

Conclusions

This should typically be one or two sentences or bullet points. When presenting your poster,
you should spend some time explaining the implications and significance of your findings to the
audience as your ideas may help change practice or generate further research.

References
Include references where information is cites but it important but use citations sparingly.

Ethics statement and Funding

If your SARP Course project requires compliance approval for using human subjects (IRB),
animals (IACUC), or biohazardous materials (IBC) please include a statement that this project
was approved and provide a protocol number. If this project did not require institutional
compliance, a statement attesting to that fact should be provided. If your project was funded
by a grant, please add a statement acknowledging the funding source.

Additional considerations for your Poster Presentation:

e Your Poster Presentation will be assessed by a faculty member using a rubric available in
the SARP Syllabus and on the SARP Website. Review this assessment rubric so you’re
familiar with how elements of your Poster Presentation will be graded.

e Be certain to work closely with your mentor on Poster Presentation and obtain and
incorporate feedback Poster Presentation.

o Practice your presentation with your lab, colleagues, friends, etc. Ensure you can
explain all aspects of your poster, remember there is a question answer session
as part of the presentation.
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e Provide relevant citations using the format suggested in the AMA Style Manual.
e Be certain to read the cited references so the Poster Presentation has scholarly integrity.
e Edit your Poster Presentation carefully:
o Proofread (suggestion: have a naive reader look at your final draft).
o Check spelling
o Check grammar
o Check the accuracy of your figures (do you have titles and labeled axes)
e Be certain your SARP Course project mentor is closely involved in this process.
e Be sure toinclude a Texas Tech Health El Paso institutional logo as well as a logo from
your mentor’s institution (if your project was done outside of Texas Tech Health El Paso).

Integrity Issues

Students are required to demonstrate a high level of intellectual and personal integrity during
all activities related to completion of the SARP Course, in alignment with their professional
identity formation as physicians. This includes communicating clearly and honestly and treating
all staff, students, faculty and other participants with respect and dignity.

Grading of the SARP Course Poster Presentation

Following grading by FSOM faculty reviewers using a grading rubric (available in the SARP
Syllabus and on the SARP website), a Pass or Not-Yet-Pass determination will be made. If Pass,
the grading rubric will be deposited in the individual student’s ePortfolio. If Not-Yet-Pass, the
student will be contacted by email, the grading rubric included, and provided 2 weeks to revise
and represent the Poster Presentation to SARP Directors or faculty reviewers. If Pass, the
grading rubric for the revised Poster Presentation will be deposited in the individual student’s
ePortfolio. If Not-Yet-Pass, the student will receive a grade of ‘FA’ (Fail) on their official
transcript for PSAP 7401 and will be referred to the Committee on Student Grading and
Promotion (GPC).

SARP Course Objectives for the Poster Presentation:
The following SARP Course Objectives are addressed by completing the SARP Course Poster
Presentation:

o Objective 1: Students will develop a research question or project theme, identify a
faculty mentor, and complete all requirements for the SARP Course.

o Objective 2: Students will learn how to search the literature, identifying previous
knowledge and theory that provides context and relevance for their project.

o Objective 4: Students will choose and employ adequate methods for the acquisition
and statistical analysis of data and information for their project.

o Objective 5: Students will submit a Poster Presentation for their project, providing a
concise summary of the project execution, data acquisition and analysis, and
conclusions.

o Objective 6: Students will demonstrate clear and effective communication skills (oral
and written) in the presentation of their project.
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Objective 7: Students will learn about protection of human and animal subjects
involved in research.

Objective 8: Students will learn and exhibit ethical principles in the design and
execution of their projects.

Objective 9: Students will exhibit attitudes and behaviors consistent with
professional conduct of research and scholarship.

Objective 10: Students will submit each assignment by the deadline and respond to
all communications and feedback in a timely and professional matter.

Objective 11: Students will collaborate generously and professionally with their
mentor, faculty, students, and staff during completion of their research project.
Objective 12: Students will learn principles of self-directed and life-long learning and
apply these to the design and execution of their projects.

Objective 13: Students will learn the principles of self-efficacy, monitoring and
sharing personal progress through self-evaluation and reflection, and SARP Course
evaluation.
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SARP Poster Presentation Assessment Rubric

Reviewer Grading Rubric for SARP Course Poster Presentations

Instructions for Reviewer: Please use the following category descriptors to give the
student feedback on the quality of his/her project. This rubric is meant to provide the
student with a feel for how well they did relative to both their peers and your
expectations for a project at this stage of their career. Additionally, please provide
narrative feedback regarding the strengths of the poster and presentation as well as any
areas where you see potential for improvement.

Student Name:

Student Mentor:

Project Title:

Poster Appearance

The poster is visually unappealing, cluttered, or difficult to read.

Needs . . .

The formatting, color scheme, and layout hinder understanding and
Improvement

engagement.

The poster is moderately visually appealing, but improvements
Satisfactory could be made in terms of organization, clarity of visuals, and

legibility of text.

The poster is visually appealing, well-organized, and effectively
Excellent utilizes appropriate visuals, fonts, colors, and layout to enhance
comprehension and engagement.

Poster Content

Needs The content of the poster is incomplete, lacking in depth, or fails to
Improvement address key aspects of the research project.

The content of the poster is present but lacks coherence, contains

Satisfactory . . . ) . .
inaccuracies, or includes irrelevant information.

The content of the poster is comprehensive, accurate, and
Excellent effectively presents the research project, including the research
guestion, methodology, results, and conclusions.

Presentation and Communication

The presenter fails to effectively communicate the research project,
lacking organization, clarity, and engagement. The presentation
lacks structure and coherence.

Needs
Improvement

The presenter communicates the research project but with limited
Satisfactory clarity, relying heavily on reading from the poster, lacking
engagement with the audience

The presenter effectively communicates the research project,
engaging the audience with a clear and well-structured

Excellent presentation. They demonstrate strong verbal and non-verbal
communication skills and provides additional insights beyond the
poster content.

Response to Audience Questions
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Needs
Improvement

There are significant concerns regarding the research and academic
integrity, including potential ethical issues, lack of transparency, or
improper citation practices.

Satisfactory

The poster demonstrates awareness of research and academic
integrity, but there are minor concerns or oversights.

The poster shows a strong commitment to research and academic

Excellent integrity, including appropriate ethical considerations, transparent
data collection and analysis, and accurate and consistent citations.
Overall Project Poster Presentation
Needs There are significant concerns regarding the quality of this poster
presentation. There are significant concerns regarding the research
Improvement

and academic integrity, including potential ethical issues

Satisfactory

The poster presentation provides sufficient information but there
are minor concerns or oversights. The poster presentation
demonstrates awareness of research and academic integrity, but
there are minor concerns or oversights.

Excellent

The poster presentation logical, and convincingly presented
effectively communicating all aspects of the plan. The poster
presentation shows a strong commitment to research and
academic integrity, including appropriate ethical considerations,
transparent data collection and analysis.

If a reviewer classifies your overall Poster Presentation as “needs improvement” consult
with your project mentor and SARP Directors to determine a plan for remediation.

Reviewer Comments:
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Guidelines for the Progress Report

Progress Reports are due for students completing their SARP Course by Track 2 or Track 3
(Figure 1). Progress Reports provide concise updates on the status of your SARP Course project
and must be approved by your SARP Course project mentor.

SARP Completion Tracks

AY 2 AY 3 AY 4

CITI Training 1
COl Traning_ m Poster
Project Plan_ Re po rt -

Develo IDevelop=> a research question or interest

Track 1: 1

a research mentor
Re ne project plan

| xecute=> project

CiIm Training | Progress Final
COI Traning Poster
Project Plan. Ri&t Report

Develo IDevelop= a research question or interest

Track 2:

a research mentor

- prOJect plan
Execute project

k CITI Training Proress Proress Final Post
TraC 3: rosep | Report Report Report | —2=€f

Develo [Develop=> a research question or interest

a research mentor

| Refine > project plan
I

Execute=> project

Figure 1

Progress Report Points of Emphasis

e If you have any questions or concerns about your SARP Course Project Progress
Report, don’t hesitate to contact the SARP Course Faculty Co-Directors or SARP
Director via SARP-ELP@ttuhsc.edu. Deadlines and additional information are
available on the SARP Website.

e Your SARP Course project mentor is responsible for approving your Progress Report.
Work proactively to develop a solid working relationship with your mentor to
maximize both the success of your project and your professional development.

e Your Progress Report must be submitted electronically through the REDCap portal.
You will receive an email invitation prior to the deadline. You need to submit 2
Progress reports for completing the SARP Course by Track 2, and 4 Progress reports
for completing the SARP Course by Track 3 (see Figure 1).

Your SARP Course Progress Report will be submitted through REDCap and contain the following
elements:
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e Student name and R-number

e Expected graduation class (e.g., C2027)

e Student email address

e Date

e Title of SARP Course project

e Mentor name and affiliation

e Mentor email address

e Compliance update

e Project tasks completed to date

e Expected completion date for the SARP Course

Be certain to work closely with your mentor on completing Progress Report. Your mentor will
formally sign-off on this document through the REDCap software.

Project Information on Record

This information should correspond to the title of the project for which you previously
submitted a Project Plan. If you are changing projects or working with a new mentor on the
same project, you need to submit a Project Change Request (form available in the Syllabus
Appendix, on the SARP Website, and on Elentra).

Compliance
If your SARP Course project requires compliance approval for using human subjects (IRB),

animals (IACUC), or biohazardous materials (IBC), it is your responsibility to work with your
mentor to document these in the Progress Report. Clearly describe what compliance is in place
or the schedule for obtaining compliance. Please note no data collection should occur without
compliance documentation being approved by the institution. The letter from the IRB, IBC
and/or IACUC must be up to date and include your name on the protocol.

Project Tasks
Here is where you will check off what portions of your project are completed (Literature

Review, Specific Aims, Data Collection/Review, Data Analysis, Final Report, and Poster
Presentation). Briefly describe the progress for each unfished element with particular regard to
the completion of each Specific Aim.

Anticipated Completion
Select an anticipated completion time for submission of the Final Report and Poster
Presentation.

Additional Details

There is a free response space in REDCap where you can include any details you think the SARP
team should be aware of regarding your project.

Additional considerations for developing your Progress Report:

65



SCHOLARLY ACTIVITY AND RESEARCH PROGRAM STUDENT HANDBOOK

Your Progress Report will be assessed by the SARP team but is not graded. This
Progress Report is a means to maintain accountability for progressing through the
SARP course requirement and to make the SARP team aware of any potential issues
with completion of your SARP Course project and serves as formative feedback
regarding progress of a SARP Project.

Be certain your SARP Course project mentor is actively involved in this process.

Integrity Issues

Students are required to demonstrate a high level of intellectual and personal
integrity during all activities related to completion of the SARP Course, in alighment
with their professional identity formation as physicians. This includes communicating
clearly and honestly and treating all staff, students, faculty and other participants
with respect and dignity.

SARP Course Objectives for the Progress Report:

The following SARP Course Objectives are addressed by completing the SARP Course Progress

Report:
O

Objective 1: Students will develop a research question or project theme, identify a
faculty mentor, and complete all requirements for the SARP Course.

Objective 6: Students will demonstrate clear and effective communication skills (oral
and written) in the presentation of their project.

Objective 7: Students will learn about protection of human and animal subjects
involved in research.

Objective 9: Students will exhibit attitudes and behaviors consistent with
professional conduct of research and scholarship.

Objective 10: Students will submit each assignment by the deadline and respond to
all communications and feedback in a timely and professional matter.

Objective 11: Students will collaborate generously and professionally with their
mentor, faculty, students, and staff during completion of their research project.
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Guidelines for Project Change Request

The Project Change Request is designed to provide notification for a change in the status of

your SARP Course project. This change in status can occur due to several circumstances. Each
scenario is described below, along with the corresponding information you will need to submit
as a Project Change Request.

1. You are continuing to work on the same project as described in your original Project
Plan, but with a new mentor.

In this case, you need to complete a REDCap form with the new mentor’s name and
contact information, briefly describe why you have a new mentor, and update your
expected project completion date (choose Track, see Figure 1). The original mentor
(if available) and the new mentor will need to sign off on the REDCap Project Change
Request.

If project requires an IRB, IBC, or IACUC forms, you need to ensure your new mentor
is listed on these documents.

2. You are continuing to work with the same mentor (as documented in your Project Plan)
but want to switch to a new project.

In this case, you will describe why you are switching to new project.

This Project Change Request also requires a new Project Plan to be submitted
according to the Project Plan guidelines. This new Project Plan will be reviewed and
assessed by a faculty member using the grading rubric available in the SARP Syllabus.
You will need to update your expected project completion date (choose Track, see
Figure 1).

Your continuing mentor will need to sign off on the REDCap Project Change Request.
If the new project requires an IRB, IBC, or IACUC forms, you need to ensure your new
mentor submits these documents and adds you to the application(s).

3. You want to change to a new SARP Course project and a new mentor.

In this case, you need to describe why you are switching to new mentor and a new
project.

This Project Change Request also requires submitting a new Project Plan according to
the Project Plan guidelines. This new Project Plan will be reviewed and assessed by a
faculty member using the grading rubric available in the SARP Syllabus.

The new mentor will need to sign off on the REDCap Project Change Request

Update your expected project completion date (choose Track, see Figure 1).

If the new project requires an IRB, IBC, or IACUC forms, you need to ensure your new
mentor submits these documents and adds you to the application(s).

Project Change Request Points of Emphasis

There is no deadline for submitting a Project Change Request; however, you should
submit as soon as possible after your SARP Course project trajectory changes,
ensuring to keep SARP administration current, and to obtain any useful guidance or
advice and IRB, IBC, and/or IACUC documents submitted for completing your SARP
Course requirement.
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e Access to the Project Change Reguest can be requested from the SARP Email. Once
received a REDCap link will be sent to you for completion.

e The SARP Syllabus, Guidelines, and additional information can be found on the SARP
Website.

e |f you have any questions or concerns about your SARP Course Project Progress
Report, don’t hesitate to contact the SARP Course Faculty Co-Directors or SARP
Director via SARP-ELP@ttuhsc.edu.

SARP Completion Tracks

AY 1 AY 2 AY 3 AY 4
| || || || |

Develop= a research question or interest

a research mentor
| Refine project plan
|Execut§> project

CiTl Training | Progress

Tra k 2. COI Traning R t

C : ProjectPlan | Report
Develop= a research question or interest

a research mentor
project plan
I

Final
— Poster
Report -

Execute project
am Training | Progress Progress Final
M- - R_e;mt Re—t
a research question or interest
aresearch mentor
[ Refine= project plan
| Execute=> project

Figure 1

SARP Course Objectives for the Progress Change Request:
The following SARP Course Objectives are addressed by completing the SARP Course Project
Change Request:
o Objective 6: Students will demonstrate clear and effective communication skills (oral
and written) in the presentation of their project.
o Objective 9: Students will exhibit attitudes and behaviors consistent with
professional conduct of research and scholarship.
o Objective 10: Students will submit each assignment by the deadline and respond to
all communications and feedback in a timely and professional matter.
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